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Important Notice 

COPYRIGHT 
The material in this document is copyright to Fairlight.AU Pty Ltd, and may not be quoted or 
reproduced in any form without written permission from the company. 

Fairlight is a trademark of Fairlight.AU Pty Ltd. All other trademarks are the property of their 
respective owners. 

LIMITED WARRANTY POLICY 

All the software and hardware provided with, or purchased especially for, Fairlight products 
has been tested for functionality. Fairlight.AU Pty Ltd will make its best efforts to correct re-
ported defects for future releases subject to technical practicalities. Fairlight.AU will also 
replace any defective media on which software has been delivered provided that the item to 
be replaced is returned to the dealer who supported the product within 90 days of purchase. 

Fairlight.AU Pty Ltd makes no warranty or representation either expressed or implied with re-
spect to the system's performance or fitness for a particular purpose. 

In no event will Fairlight.AU Pty Ltd be liable for direct or indirect damages arising from any 
defect in the product or its documentation. Further, Fairlight.AU Pty Ltd will not accept any 
liability for any programs, sounds, audio recording or sequences stored in or used with Fair-
light products, including the cost of recovery of such data. 

Product features and specifications are subject to change without notice. Fairlight.AU re-
serves the right to change any part of this document without notice. 

The warranties, remedies and disclaimers above are exclusive and take precedence over all 
others, oral or written, express or implied, to the extent permitted by law in the geographical 
area of the product's use. No employee of Fairlight.AU, agent, distributor or employee of an 
agent or distributor is authorized to offer any variation from this policy. 

Copyright © 2007 
Fairlight.AU Pty Ltd, 
Unit 3, 15 Rodborough Rd, 
Frenchs Forest, NSW 2086, 
AUSTRALIA. 
Telephone +61 2 9975 1777 
Fax +61 2 9975 1999 

END USER LICENSE AGREEMENT 

You have acquired a device (“DEVICE”) which includes software licensed by Fairlight.AU from 
one or more software licensors (“Fairlight.AU's Software Suppliers”). Such software products, 
as well as associated media, printed materials, and “online” or electronic documentation 
(“SOFTWARE”) are protected by international intellectual property laws and treaties. The 
SOFTWARE is licensed, not sold. All rights reserved. 

IF YOU DO NOT AGREE TO THIS END USER LICENSE AGREEMENT (“EULA”), DO NOT USE 
THE DEVICE OR COPY THE SOFTWARE. INSTEAD, PROMPTLY CONTACT Fairlight.AU FOR 



INSTRUCTIONS ON RETURN OF THE UNUSED DEVICE(S) FOR A REFUND. ANY USE OF THE 
SOFTWARE, INCLUDING BUT NOT LIMITED TO USE ON THE DEVICE, WILL CONSTITUTE 
YOUR AGREEMENT TO THIS EULA (OR RATIFICATION OF ANY PREVIOUS CONSENT). 

GRANT OF SOFTWARE LICENSE. This EULA grants you the following license: 

 You may use the SOFTWARE only on the DEVICE. 

 NOT FAULT TOLERANT. THE SOFTWARE IS NOT FAULT TOLERANT. Fairlight.AU HAS 
INDEPENDENTLY DETERMINED HOW TO USE THE SOFTWARE IN THE DEVICE, AND 
Fairlight.AU'S SOFTWARE SUPPLIERS HAVE RELIED UPON Fairlight.AU TO CONDUCT 
SUFFICIENT TESTING TO DETERMINE THAT THE SOFTWARE IS SUITABLE FOR 
SUCH USE. 

 NO WARRANTIES FOR THE SOFTWARE. THE SOFTWARE is provided “AS IS” and 
with all faults. THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, 
ACCURACY, AND EFFORT (INCLUDING LACK OF NEGLIGENCE) IS WITH YOU. ALSO, 
THERE IS NO WARRANTY AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF 
THE SOFTWARE OR AGAINST INFRINGEMENT.   IF   YOU   HAVE   RECEIVED   ANY   
WARRANTIES   REGARDING   THE   DEVICE OR   THE   SOFTWARE,   THOSE 
WARRANTIES DO NOT ORIGINATE FROM, AND ARE NOT BINDING ON, Fairlight.AU'S 
SOFTWARE SUPPLIERS. 

 Note on Java Support. The SOFTWARE may contain support for programs written in 
Java. Java technology is not fault tolerant and is not designed, manufactured, or 
intended for use or resale as online control equipment in hazardous environments 
requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft 
navigation or communication systems, air traffic control, direct life support machines, 
or weapons systems, in which the failure of Java technology could lead directly to 
death, personal injury, or severe physical or environmental damage. Sun 
Microsystems, Inc. has contractually obligated Fairlight.AU's Software Suppliers to 
make this disclaimer. 

 No Liability for Certain Damages. EXCEPT AS PROHIBITED BY LAW, Fairlight.AU'S 
SOFTWARE SUPPLIERS SHALL HAVE NO LIABILITY FOR ANY INDIRECT, SPECIAL, 
CONSEQUENTIAL OR INCIDENTAL DAMAGES ARISING FROM OR IN   CONNECTION 
WITH THE USE OR PERFORMANCE OF THE SOFTWARE. THIS LIMITATION SHALL 
APPLY EVEN IF ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE. IN NO EVENT 
SHALL Fairlight.AU'S SOFTWARE SUPPLIERS BE LIABLE FOR ANY AMOUNT IN 
EXCESS OF U.S. TWO HUNDRED FIFTY DOLLARS (U.S.$250.00). 

 Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not 
reverse engineer, decompile, or disassemble the SOFTWARE, except and only to the 
extent that such activity is expressly permitted by applicable law notwithstanding this 
limitation. 

 SOFTWARE TRANSFER ALLOWED BUT WITH RESTRICTIONS. You may permanently 
transfer rights under this EULA only as part of a permanent sale or transfer of the 
Device, and only if the recipient agrees to this EULA. If the SOFTWARE is an upgrade, 
any transfer must also include all prior versions of the SOFTWARE. 

Obtaining Technical Support 

Users requiring technical support should contact their local distributor.  



Information can also be found on the world wide web at: 

http://www.fairlightau.com 

Manual Errors and Omission  

To help ensure that Fairlight provides the most accurate and comprehensive documentation, 
please report any errors or omissions to: 

documentation@fairlightau.com 
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Reading the Right Manual? 

Pyxis G2 has two “Themes”. To choose your theme start the Pyxis software, then select  
Setup  General Preferences  Themes and use the pull-down menu. 

Only one of the themes is described in this manual. 

 

The previous one is called EVO1, and looks thus: 

 

For information about the EVO1-themed version of Pyxis, please see the previous Pyxis 
Manual, entitled “Pyxis MT User Manual”. 

Theme: Pyxis NLV 

This is the subject of this 
manual 

Theme: EVO1 

This is NOT the subject of 
this manual 
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Chapter 1 - Introduction 

Introduction  

Pyxis G2 is a new product from Fairlight which combines the audio processing power of CC-1 
with a video-oriented interface, to create an audio/video dubber with large track capacity. 

The Pyxis G2 interface is a simple mouse and screen based GUI that makes standalone 
operation very easy. Alternatively the system can be used as a 9-pin slave in a larger system 
when deployed in a mixing or live production environment. 

About This Manual 

The Pyxis G2 User Manual provides all the information necessary to rapidly become proficient 
at operating the system in a professional audio environment. 

This manual is designed to familiarize engineers with the facilities provided by Pyxis G2. The 
terminology and concepts used in this manual assume a reasonable knowledge of audio and 
video principles and studio procedures. 
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Chapter 2 - Pyxis G2 Overview 

Introduction 

ATPyxis G2 is the latest generation digital audio/video system from Fairlight, offering 
exceptional power and speed for recording, editing and mixing. 

Configurable with up to 192 disk recorder tracks, dual video tracks capable of HD resolution, 
and up 212 physical inputs and outputs, Pyxis G2 integrates full recording capability for audio 
and video, with a simple audio editor and basic video editing. 

User Interface  

 

 

Smart Pane 

Zoom 
Moveable 
play head 

Select/grab

Timecode position 

Undo/redo 
Jump Editing 

Commands 
Transport

Track 
Selectors 

Video Display

Clip timeline 

Video scroller

Locator tiles 

Status Bar Level Meters 
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Smart Pane 

This area contains a number of different displays at different times. It may show Meters, Clip 
EQ parameters, Fade parameters, and so on. Each description of editing functions will include 
details of the Smart Pane display elements. 

To display different Smart Panels use the menu command View  Smart Pane and then 
choose the one you want. 

 

Range Display 

 

This area contains three timecode values associated with Editing Ranges. They are, 
respectively, the Range In time, Range Out time, and Range duration. 

The From button is used to place the beginning of the Range at the current position. 

The To button is used to place the end of the Range at the current position. 

The Range button toggles the Range on and off. 

When Range is switched off, these numbers show the last range that was created, which can 
be restored by pressing the Range On key, or selecting the Range On command from the Edit 
Menu. 

The button at the bottom work as follows: 
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Jump Left – causes the transport to jump to the next “jump target” to the left. 

Loop – causes the transport to loop between the From and To points. 

Jump Right – jumps to the next “jump target” to the right. 

Jump targets are chosen by the command Edit  Jump To.  

You may check  

 Marks 

 Point (heads or tails of clips on selected tracks)  

and / or  

 Fade (places in clips where a fade-out begins, on selected tracks). 

Track and Clip Area 

 

This area shows a selection of the available audio and video tracks, and the clips on them. In 
the above picture, the Video Track and Track 2 are both selected (active) while Track 1 is 
unselected. 

A complete description of all track functions is contained in the chapters that follow. 

Status Bar 

This line shows a number of items of information, as detailed in sections below. 

 

The Zoom level determines how much time is shown on the screen. To change it, hover over 
the tracks, and turn your mouse wheel. 

The Top Layers / All Layers setting controls how editing works. See Chapter 8 – Editing for 
details. 
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The Sync source controlling the system sample clock is shown at left. In this case it is the 
SX20 (Fairlight’s sync and I/O box) running on its internal crystal. 

The Timecode shown is the current position of the transport. Click on it with the mouse to 
open a Locate dialog where you can enter any timecode and go there. 

 

To the right of the timecode display are two lights which change colour as follows: 

Sync – shows green if the system has a viable sync signal, otherwise red 

Position – shows green if the system sees a viable position signal, such as timecode or 9-pin, 
otherwise red. 

The frame rate of the video and audio is shown next – in this case 25 frames per second. To 
change this, select Sync Setup in the Setup Megamode. Also see Chapter 21 – Timecode 
Setup. 

The Video type shown here is SD (Standard Definition). If you load a video file containing HD 
content (or capture one yourself) this indicator will read HD. Your system can only capture 
and play HD video if licensed to do so, and equipped with very fast hard drives. 

The sample rate of the audio is shown at the right. This is set when a Project is first created, 
and cannot be changed thereafter. 

 

The next display shows which system hard drive is being used for Audio recording at the 
moment – in this case D: Drive. The number to its right shows the time available for 
recording on the currently armed tracks (of course it will reduce as you arm more tracks, and 
as you record more audio). The leftmost number, in this case 178, is Hours. 

The machine status indicator, in this case 9pin Master, is the selected type of the first 
machine (M1). The M1, M2 and M3 buttons can be used to enable three different machines, 
which can be synchronised if properly set up. See Chapter 22 – Machine Control for details. 

Editing Tools 
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The editing tools provide single button commands for editing audio and video clips. Mouse 
editing is also available. 

Transport Controls 

 

 

The central group of buttons (shown above) does exactly what you expect, namely Rewind, 
Fast Forward, Play, Stop and Record. 

Both Rewind and Fast Forward can be clicked repeatedly for increased speed. 

Record is a single-press button and can be entered from any transport state. 

The leftmost group of buttons (shown immediately above) works as follows: 

   Jump Left – pressing this button causes the transport to jump to the next 
Mark or Clip boundary* to the left.  

You can also use the Left Arrow key on the QWERTY keyboard to jump left. 

   Jump Right – jumps to the next Mark or Clip boundary* to the right.  

You can also use the Right Arrow key on the QWERTY keyboard to jump right. 

   Frame Left – moves the transport one frame to the left. 

   Frame Right – moves the transport one frame to the right. 

Jump targets are chosen by the command Edit Settings  Jump To.  

You may check  

 Marks 

 Point (heads or tails of clips on selected tracks)  

and / or  

 Fade (places in clips where a fade-out begins, on selected tracks). 
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Track Number Selectors 

 

Click on the numbered buttons to control how many tracks are displayed. For example, click 
on 8 to see 8 tracks on the screen. Note that when the Video Track is switched on, it is 
counted in this number. 

Click the Up Arrow button to move the track display upwards. For example, if Tracks 5 to 8 
are currently displayed, clicking Up will cause Tracks 4 to 7 to be displayed. 

Click the Down Arrow button to move the track display downwards. 

Click the Top button to move the display to the top i.e. starting at the Video Track, if 
switched on, otherwise at Track 1. 

Click the Bottom button to move the display to the bottom i.e. ending at the highest track 
number in the project. (You choose how many tracks will be in the project when you first 
create it.) 

Starting the System 

Step 1 Start the host computer (PC) by turning on its power switch. The PC will boot the 
Windows operating system and display your PC desktop. 

Step 2 Power on the audio interface box(es) (SX-20 and optional SX-48s). 

Step 3 Start the Dream II application by double-clicking its desktop icon, or by selecting it in 
Start  All Programs  Fairlight  Pyxis G2  Pyxis G2 
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System Shutdown 

Step 1 Exit Pyxis G2 by selecting Exit from the File Menu, or by the keystroke combination 
Alt-F4. 

Step 2 If a project is open, the system will prompt you to save any changes that have 
occurred since it was opened. 

 
Click Yes if you want to save the changes in the project. This may take a minute or 
so, during which a progress bar will grow in size. 

Organising Your Screen 

Pyxis G2 normally fills the monitor screen, expanding automatically to fit. Note: Screen bit 
depth MUST be 24 bit. 

If you wish it to reduce its size, edit the Pyxis icon that you use to start the system, as 
follows: 

Step 1 Right click the icon you use to start the system. It looks like this:  

Step 2 Select Properties from the menu of commands. 

Step 3 Select the Shortcut tab (if not already selected) 

Step 4 Edit the text in the “Target” text box. Normally it reads as follows: 

“C:\Program Files\Fairlight\PyxisG2\Pyxis G2.exe" Change it to: 

"C:\Program Files\Fairlight\Pyxis G2\Pyxis G2.exe" –HEIGHT1680–WIDTH1050 

(but use your own numbers for desired height and width). 

Step 5 Click OK and restart the application. 

Using the System 

Follow the instructions in the following chapters to quickly learn all the operating procedures 
necessary for completing production tasks with Pyxis G2. 
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Chapter 3 - Projects 

Introduction 

Pyxis G2 uses ‘Project’ files to store your work. All audio recordings, editing and file imports 
are done within Projects. A project contains all the edit information, plus Pyxis G2 settings, as 
well as links to the audio and/or video files that have been incorporated into the project. Edits 
performed on the audio and video data are non-destructive and are represented by clips 
which refer to pieces of audio or video data. 

As with other standard Windows applications, Projects must be saved to disk before being 
closed, or all changes since opening will be lost. Project files are given the .DR2 filename 
extension by default. 

Opening a Project 

Step 1 Click the Project button at the right of the screen, then click the Open button that 
appears below. If there is already a project open, the system will ask if you want to 
save it. 

Step 2 The system displays a list of all the projects in the last folder you visited. If 
necessary, browse to other folders to see other projects that you may wish to open. 

 

Step 3 Click on the name of the Project you wish to open, then click the Open button. The 
system will load all of the audio and reconnect to external files that were used last 
time in the project. 
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Opening a Recent Project 

Pyxis G2 keeps a list of your most recent projects. To open one of these, click File in the 
Menu Bar. 

Yo
ur four most recent projects are shown at the bottom of the menu list. Simply click on one of 
them to open it again. 

Opening Files Across the Network  

If your Pyxis G2 system is part of a PC network, the system will allow you to open a Project 
located across that network, for example on a server. In this situation the number of tracks 
that can be played may be limited, depending on network bandwidth and other traffic. In 
addition, the response of the system may be slower than usual. 

For best performance, it is always best to locate projects on the local hard drive in your Pyxis 
G2 PC. 

Creating a New Project 

Step 1 Click the Project button at the right of the screen, then click the New button that 
appears below. If there is already a project open, the system will ask if you want to 
save it. 

Step 2 The system displays the New Project dialog. 

 

 Step 3 Fill in the form presented by the system. 

Project Name The name you enter here cannot be changed before saving the file, though it 
is possible to Save As under a different name. It is also possible to rename 
the project, as explained below. 

Comment Put any text in here for your convenience. It will be shown at the top right of 
the screen. 
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Sample rate The system supports sample rates up to 96 kHz. This is set now when the 
project is created, and cannot be changed thereafter. 

Frame Rate The value you place here can be changed in the Sync display at any time 
afterwards. It should match the incoming timecode format for correct 
synchronisation. 

Video Add Pyxis Track. If this is checked the system will display a video track at the 
top of the track display. 

Audio Tracks Choose the number of tracks you would like in the project. This cannot be 
changed later. 

 Step 3 Click OK to create the project. 

Closing a Project 

Use File  Close 

If you have changed anything since opening the project, the system will ask if you want to 
save it. This must be done for your recent changes to be saved. 

Deleting Projects 

A project can be deleted using Windows Explorer, like any other file. It is also possible to 
delete a file in the Open or Save dialogs, as follows: 

Step 1 Use File  Open. If there is already a project open, the system will ask if you want 
to save it. 

The system will prompt you to save the current project if it has changed. You may 
respond either way, since you are not actually going to close the project. 

Step 2 The system displays the appropriate dialog. 
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Step 3 Right-click on the file you wish to delete. The system will display a list of commands. 

Step 4 Select delete from the list of commands. The system will ask you to confirm that 
you wish to delete the file. 

Renaming Projects 

A project can be renamed using Windows Explorer, like any other file. It is also possible to 
rename a file in the Open or Save dialogs, as follows: 

Step 1 Use File  Open. If there is already a project open, the system will ask if you want 
to save it. 

Step 2 The system displays the appropriate dialog. 
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Step 3 Right-click on the file you wish to rename. The system will display a list of 
commands. 

Step 4 Select rename from the list of commands. The system will highlight the current name 
of the file, allowing you to edit it. Press the ENTER key after editing, to confirm your 
new name for the project. 

Saving As Other Names or into Other Formats 

The Save As command allows you to make a new version of the currently open file. This may 
have a different name and/or file format than the project you opened. 

Step 1 Select the Save As command from the File Menu. 

Step 2 The system displays the appropriate dialog. 

Step 3 Choose an alternative file format if required. The system will allow to save into MT, 
DR2 or MFX3+ format. Note that DR2 is the most powerful format, and the other two 
support earlier systems and their software. 
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Chapter 4 – Audio Tracks & Transport 

Introduction 

Pyxis G2 provides up to 192 disk recorder tracks routed via dedicated track feeds. It supports 
up to 256 analog and digital inputs and outputs which may be patched to tracks as required 
(see Chapter 7 – Patching and Assignment for more details on patching). 

In addition, Pyxis G2 provides a video track and, with the appropriate graphics card installed, 
the means to capture video directly. 

Displaying Tracks 

Number of Tracks 

Disk recorder tracks are displayed on the screen. Select the number of tracks to display using 
the Track Number selectors shown below. 

 

Click on the numbered buttons to control how many tracks are displayed. For example, click 
on 8 to see 8 tracks on the screen. Note that when the Video Track is switched on, it is 
counted in this number. 

Click the Up Arrow button to move the track display upwards. For example, if Tracks 5 to 8 
are currently displayed, clicking Up will cause Tracks 4 to 7 to be displayed. 

Click the Down Arrow button to move the track display downwards. 

Click the Top button to move the display to the top i.e. starting at the Video Track, if 
switched on, otherwise at Track 1. 
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Click the Bottom button to move the display to the bottom i.e. ending at the highest track 
number in the project. (You choose how many tracks will be in the project when you first 
create it.) 

You can also select the desired track view in the onscreen View Menu, like this: 

View  Tracks  Number of tracks. 

Video Track 

If your project contains a video track, you can toggle its display using the View Menu: 

View  Show Pyxis Track  Show or Hide 

The Video Track is discussed in detail in Chapter 5. 

Audio Track Colours 

Each audio track has a colour that is shown at the left, and which can be given to the clips on 
that track. Selected clips are always shown red, i.e. those touching the cursor or in a range, 
on selected tracks. 

 

To select track colours,  

Step 1 Select tracks you want to colour. 

Step 2 Use the menu: Tracks  Set Track Colour 

Tracks show colour 
tabs 

Clips can also be given 
special colours 

Selected clips are always red

Clips normally 
show the track 
colour. 
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When you choose a track colour, all clips on the track that currently have its old colour are 
given its new colour. This applies to all clips for which you have never explicitly chosen a 
colour.  

Choosing Clip Colours 

To explicitly choose clip colours, do the following: 

Step 1 Select tracks containing the clips you want to colour. 

Step 2 Move the transport so the clips are under the cursor, or make a range using the From 
and To keys. The clips should be red. 

Step 3 Use the menu: Edit  Set Clip Colour 

Click to choose a 
colour for all selected 
tracks. 

Click to force all clips 
on a track to adopt its 
colour, regardless of 
what they are now. 
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Click to choose a 
colour for all selected 
(red) clips. 

Click to return the 
selected clips to their 
track colour. 

There are two extra 
colours just for clips, 
useful for reminding 
you that they need 
attention. 
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The Clip 

When audio is recorded or imported into Pyxis G2 it is displayed as a clip. The clip is a 
reference to the audio data stored on disk. Clips can be cut, copied or moved without 
affecting the original audio data. 

When new clips are recorded or pasted above existing clips, the clips become layered one 
above the other. Normally only the top clip is seen and heard during play-back. DREAM II 
now allows all layers to be seen simultaneously. To do this,double-press the Takes button in 
the Editor Megamode, or select/deselect Display Layering in the onscreen View menu. This is 
described in more detail in Chapter 7 – Editing. 

The left end of the clip is known as the head. The right end is the tail. 

Clips also contain information about the original timecode location of the audio data when 
recorded, and the current timecode location of the displayed clip.  

If a clip shows only a portion of the associated audio data on disk, it may be trimmed to show 
more. 

 

Clip Display Information 

You can choose which information is displayed in clips using the command: View  
Displayed Clip Information. The system displays a dialog like this: 
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Note that Frame Rate, Video Size and Codec are only shown on Video clips (see Chapter 34 – 
Pyxis Track for details about video). 

Multichannel Clips 

Multichannel clips are linked for editing operations. They are displayed with a link (chain) 
icon.  

 

You can create multichannel clips in two ways: 

 By importing a multi-channel Wave or other file 

 By Recording into a Link Group of tracks 

Once a clip has been defined as multichannel, operations on one channel of the clip (eg – 
EQ) affect all other channels.  

Multichannel clips can be broken apart using the command Edit  Cleave Multichannel 
Clips. 

Selecting Tracks 

Feeds may be grouped and linked in various formats. Selecting the Group Master or a 
member of a Link Group will select all members of the group. See “Grouping” on page 85 for 
more details on group behaviour. 

Press a dark onscreen track selection key to add that track to the selection. 

Press a lit onscreen track selection to remove that track from the selection. 
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Click and drag your mouse in the onscreen track selection pane to select/deselect multiple 
tracks. 

 

To select a single track, double click its number. All other tracks will be deselected. 

Another way of selecting a track is to ctrl-click on a clip. This cannot be used to deselect a 
track. Ctrl-clicking will also select the clip, and create a range (or extend the current one) to 
include that clip. 

Note: the mouse can also be used to: 

 Mute or unmute a track – click the M 

 Solo or unsolo a track – click the S 

 Arm or disarm a track – click the button at left (the track must have an input patched 
to it, before it can be armed) 

Time Scale and Display Zooming 

The track display represents a 24 hour continuous loop. The timescale can be zoomed from 
one sample across the screen to eight hours. The Zoom number and screen width are shown 
at the upper left of the screen. 

 

To change zoom range: 

Turn the Mouse wheel. 

Or 

Click on the Zoom icon and drag the mouse up or down. 

 

Track display selection and zooming is possible while playing and recording. 

Click here to select the 
video track for editing 

Click here to select 
Track 1 

Click here to 
deselect Track 2 
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Timescale display 

Timecode positions can be displayed in whole frames, frames with subframes, frames with 
subframes and samples, feet and frames in either film format, or Bars and Beats. 

For all timescale choices, select View  Timescale and choose one of the options. 

 

Bar/Beat display 

Positions can be displayed in bars and beats. To enable this, use the Edit Screen menus, and 
click View  Timescale  Bars and Beats. The Edit Screen shows dark bar lines and light 
beat lines. 

To set up parameters, go to Setup  Bars and Beats Setup. This displays a dialog with 
the following parameters: 
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Tempo 

Expressed as beats per minute. The box on the right allows you to choose the beat value 
used in specifying the tempo. In some cases you may wish to specify beats differently from 
the time signature. 

Time 

This is the time signature, expressed in the usual way. 

Origin Time 

This is the timecode where the first bar starts. To set it, locate to the timecode of the first 
bar, and click the button labeled “Set 1.1.1”. 

You may move the transport earlier than the first bar, which is negative bar territory. Note: 
there is no zero bar – the number goes from -1 straight to 1.  

Snap 

Snap editing is used when dragging clips with the mouse. You may set the snap points to any 
musical interval in the bar. To switch snapping on, click Edit  Snap Editing. Note that 
several types of snap may operate at the same time e.g. clip and beat. This can lead to 
conflicts if two snap points are in close proximity. 

BPM from Range 

The system will calculate accurate tempos based on fitting to a range. To do this, mark the In 
and Out points of the range using the From and To keys. Now enter the number of bars that 
should fit in the range, and click the button labelled “BPM from Range”. 

Audio Scrollers 

Audio Scrollers give you a close-up waveform view of one or two tracks that can be useful for 
editing or mixing. 
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They effectively provide an extra zoom range to use on tracks of particular interest, while the 
rest of the screen gives more contextual information. 

You can select tracks for scrollers using the Setup item in the menu at: 

Setup  General Preferences  Scrollers 

 

 

You can also toggle scrollers on and off for the first 10 tracks using the QWERTY keyboard: 

 Ctrl+1 toggles the Track 1 scroller 

 Ctrl+2 toggles the Track 2 scroller 

 …………….. 

 Ctrl+0 toggles the Track 10 scroller 

Only two audio scrollers can be displayed at a time. Trying to add more with the above 
method will not work. 
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While audio scrollers are displayed you can: 

 Click at any point to locate to that position. 

 Click and drag the scroller to move the transport. 

 Zoom the scroller by floating the mouse above it and turning the mouse wheel. 

Other scroller preferences: 

 Scrollers as outline – you can display the scroller waveform in solid or outline format. 

 Scrollers on full screen video – you can choose to have the scroller display present 
when full screen video has been chosen. This is useful for moving the timeline. 

 Scrollers follows current track – the scroller automatically chooses the most-recently-
selected track for display. 

Waveform in Record 

Audio Scrollers display the incoming waveform during record, as well as the playback 
waveform. This can be useful for anticipating the punch-out point on a track. 

 

Waveforms are also shown on the normal track view while recording. 

Note: the Video Scroller is described in Chapter 34 – Pyxis Track. 

Transport Controls 

The PLAY, STOP, FF and REW controls work in a similar manner to a tape machine. You can 
increase the fast-forward and rewind speeds by pressing the respective keys multiple times. 
This accelerates through 8, 24, 60, 150 and 360 times play speed. 

To enter record click the REC key. 

 

 

The Space bar on the QWERTY keyboard can also be used to toggle the transport between 
Play and Stop. 

The lower row of buttons works as follows: 

 Jump Left – pressing this button causes the transport to jump to the next Mark or 
Clip boundary to the left.  
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You can also use the Left Arrow key on the QWERTY keyboard to jump left. 

 Jump Right – jumps to the next Mark or Clip boundary to the right.  

You can also use the Right Arrow key on the QWERTY keyboard to jump right. 

 Zoom – click on this button and drag upwards or downward to zoom the Track 
display in or out. 

 Frame Left – moves the transport one frame to the left. 

 Frame Right – moves the transport one frame to the right. 

Jump targets are chosen by the command Edit Settings  Jump To.  

You may check  

 Marks 

 Point (heads or tails of clips on selected tracks)  

and / or  

 Fade (places in clips where a fade-out begins, on selected tracks). 

Jump overrides 

Jumps can be given temporary targets by holding down modifier keys. This is only true when 
jumps use the left and right arrow keys on the QWERTY keyboard. 

Ctrl + Jump – jumps to marks only 

Shift + Jump – jumps to points only (heads and tails) 

Mouse Dragging 

The mouse can be used to move the transport. Simply right-click anywhere in the Track 
Display and drag horizontally to move the transport. Audio is not heard while this takes place. 

You may also move the transport by clicking and dragging in any of the scrollers. 

Locator functions 

Rapid navigation through the project is achieved using the following methods: 

Locate to Timecode 

Click the timecode field near the top of the screen 

Type a Timecode 

Click OK. 

Create Video Locators 

Stop the transport at a frame whose location you would like to store. 

Click an empty Locator button at the right of the video screen. 

Click an active Locator button to instantly locate to its timecode. 
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Jumping 

Pressing the Jump keys will move the transport instantly to the next clip or Video 
Locator. 

Using the mouse 

Right-click anywhere in the Timeline to locate there.  

Right-click and drag on the Edit Screen to move the transport. 

Left-click in the Video Scroller to locate to the start of the clicked frame. 

Right-click in the Video Scroller to locate to the place you clicked in the clicked frame. 

Selecting a Range 

 

A Range allows a group of clips across one or multiple tracks to be selected. Many functions 
provided by Pyxis G2 require the use of a Range. Use the From and To buttons at upper left 
of the screen to set ranges. Range mode may be turned on or off by pressing the Range 
button. 

Setting a Range With the Mouse 

The mouse can be used to set a range. To do this, click in a part of a track where there is no 
clip, then drag the mouse to another timecode and release it. The time swept out by the 
mouse will become the new range. 

To remove a range, click where there is no clip, and the range will disappear. 

Selecting Clips with the Mouse 

Clicking on a clip while holding down the Ctrl key on the  QWERTY or the BLUE key on the 
DREAM II controller keyboard causes the clip to be selected (or deselected if it was already 
selected). In addition, a range is created, exactly large enough to contain all clips that were 
already selected, plus the one just clicked. 

Empty 
Locators 

Active 
Locators
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The newly created range does not, however, select any clips that were not previously 
selected, other than the one just clicked. Put more simply, Ctrl-clicking a clip adds to the 
selection without selecting any other clips. 

Similarly, a clip that was already selected can be deselected by Ctrl-clicking, as long as it is 
within a range. 
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Chapter 5 - Video Track 

Introduction 

Pyxis G2’s Video Track is a built-in video disk recorder and editor. The Video Track is also 
known as the Pyxis Track. 

It can import files of many formats, and export to many formats. Some of these formats 
require special licences to operate. See below for import / export information. 

Creating a Pyxis Track 

Before using Pyxis Track, a video track must be added to the project. This can be done in two 
ways. 

 When creating a new project, select the Add Pyxis Track checkbox, shown below. 

 

For a project that is already created, use the command Tracks  Add Pyxis Track 
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Once created, the Video track appears at the top of the Edit Screen: 

 

Hiding and Showing the Video Track 

To hide or show the video track on the Edit Screen use the menu commands: 

View  Show Pyxis Track  Show  and 

View  Show Pyxis Track  Hide 

Video Track Display Offset 

When using a monitor with an inbuilt display, such as an LCD or plasma screen, the picture 
may be one or two frames late at play speed. You can adjust for this using the General 
Preferences dialog. To access this, click  

Setup  General Preferences  Playback 
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The control allows you to advance playback by one or two frames. While in stop or Jog, the 
correct frame is output, but in play the advancement is activated. 

You can have a separate setting for your Decklink output and your VGA output, since they 
are likely to feed different monitors. 

Loading Video into Pyxis Track 

There are two methods for loading video into Pyxis Track. In both cases, the video track must 
be visible on screen. 

Importing a Video File 

Step 1 Make sure that the Pyxis track is displayed. If not, see above. 

Step 2 Click File  Import  Video File. 
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Step 3 The following dialog box is displayed 

  

The following file types can be imported using this method: 

 Quicktime (.mov),  

 Avi (.avi),  

 Windows media format (.wmv) 

 Mpeg4 files (.mp4)  

 Mpeg 1 or 2  (.mpg, .m2v, .mvf),  

 dv25 (.dv or .dif)  

 Bitmap (.bmp) or Cineon (.cin) sequence of images ( in sequentially numbered files, 1 
frame per file) 

 LongGop (requires mxf licence option, mpeg licence option, plus installation of 
Mainconcept mpeg2 directshow filter and MXFReader2.1 beta or later*. 

also any Dream/Pyxis native files which are … 

 - uncompressed (.vmu) 

 - dv25 (.dif) 

 - mjpeg (.vmj) 

 - lossless (Huffman compression)  (.vmh) 

Import by Drag and Drop 

A quick way to import video files is to use Drag and Drop, as follows: 

Click here to 
browse for the 
file you want 
to import 
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Step 1 Make sure that a Pyxis track is displayed. If not, see above. 

Step 2 Open Windows Explorer (or My Computer) and find the video file you wish to import. 

Step 3 Drag the video file from the Windows Explorer window and drop it on the video track 
in the Dream II Edit Screen. 

The following file types can be imported using drag and drop: 

 Quicktime (.mov),  

 Avi (.avi),  

 Windows media format (.wmv) 

 Mpeg4 files (.mp4)  

 Mpeg 1, 2 or 3  (.mpg, .m2v, .mvf),  

 dv25 (.dv or .dif)  

 MXF (.mxf) containing dv25, dv50, dv100(DVCPro HD) or IMX mpeg compressed 
video 

 Omf video files (.omf) containing mjpeg, dv25, or uncompressed video. 

 Thomson/Grass valley dv25 files (.vid) 

 Bitmap files (single still image) .bmp – useful for a clapper board. 

also any Dream/Pyxis native files which are … 

 - uncompressed (.vmu) 

 - dv25 (.dif) 

 - mjpeg (.vmj) 

 - lossless (Huffman compression)  (.vmh) 

MXF files require an MXF licence (dongle) 

IMX Mpeg requires an IMX Mpeg licence. 

Dv50, dv100 require a DVCPro Licence (dongle) 

Playing a QuickTime or AVI file requires that the latest available codec for that file type has 
been installed. Fairlight recommends that automatic update be switched on to ensure that the 
version remains current. 

In some cases a specific codec must be installed e.g. QuickTime files from Avid require the 
Avid codec to play them. 

For a good indication of playability, double-click a file in Windows Explorer. If the operating 
system plays the file immediately, it will almost certainly play in Pyxis Track. 

Capturing Video 

The following assumes your system is equipped with a Decklink Video capture card.  
For the purposes of the example, we will be operating in Standard Definition mode. 

Pyxis Track allows an incoming video signal to be captured directly onto the timeline. This 
requires correct configuration of both the Decklink card and Dream II. 
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Configuration of the Decklink card 

Configure the required settings for your Decklink card by navigating to 

START  Control Panel  Decklink 

 

It is critical that you select the appropriate Inputs for your system. In the example, we are 
intending to capture video from a Digital Betacam VTR, via the Decklink Component inputs. 

If you will be consistently using the same physical inputs for all video capture duties, you 
should be able to “set and forget” this value. 

Configure Dream II Video Capture options 

With Dream II launched, and a Project with Pyxis track open, navigate to 

Setup  General Preferences  Video Capture 

This window configures the Dream II part of the video capture system. 
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“Capture Size” is a default value, based on whether Dream II is launched in Standard or High 
Definition mode, and the current project sync settings (See View  Smart Pane  Sync) 

If this setting is not the format you are wishing to capture, it is recommended you consider 
exactly what format you wish your project to be, and configure it in consequence. 

The “Device” value tells Dream II which video hardware capture unit will provide the 
incoming video signal. Under normal conditions, this will be “Decklink Video Capture”. 

“Input Source” is currently not activated. Setting the correct Video Input must be performed 
within the Decklink Control Panel. (See above). 

“Record Format” is the video file and codec format for capturing the incoming video signal. 
The options available are: 

 - DV25 (DV Codec, 3.5Mb/sec, SD NTSC or PAL ONLY) 

 - MPJEG  

 - Uncompressed 
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 - Huffman Lossless 

For Standard Definition systems, “DV25” is the recommended setting. 

For High Definition systems, “Huffmann Lossless” is a good reliable option. 

Invoke Video Capture Mode 

Unlike an audio recorder, digital video capturing equipment must be in a specific “Video 
Capture Mode” in order to record an incoming signal. 

In DreamII, you can invoke this mode by navigating to 

Setup  Video Capture Mode 

 

With Video Capture Mode ON, your Decklink card will act as a loopthough device, and will 
display the incoming video signal. This is in contrast to its normal mode, where the Decklink 
card displays whatever video is already on the Pyxis track. 

Note: If no Decklink card is fitted, your system cannot operate in Video Capture Mode. It can, 
however, play back video files. 

 

With Video Capture Mode ON, you may ARM the Pyxis track, and record the incoming video 
signal, in the same way as you would record audio. 

displaying your video, use the command: 
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View  Pyxis 

 

This window is resizeable, and can be made to go full-screen with a double click on the 
window with your Left Mouse Button 

To show a window 

Video Locators 

While the Pyxis window is displayed, you may click on an empty Video Locator at any time. 
This will capture the current video frame and display it, with a timecode number. 

To locate to any Video locator, Limply click it. 

To re-order the locators, drag and drop them with the mouse. 

To delete a locator, drag it far to the right and drop it when the delete icon is displayed. 

Video locators are also displayed in the Edit Marks list (Locators list) and can be edited there. 
See Go To Mark, page 105. 

The Video Scroller 

The Video Scroller is a line of frames across the bottom of the screen, centered at the current 
frame. These frames cover the same width as the audio tracks. 

Click here to 
scroll video 
locators list. 

Video locators 
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The Video Scroller is useful because you can see specific frames and scene changes coming 
up, and use it for easy location. 

To Display the Video scroller click: 

Setup  General Preferences  Scrollers 

 

Select the Video checkbox.  

You can also use the keyboard shortcut ctrl+~ to toggle the Video Scroller on and off. 

While the Video Scroller is active you can: 

 Right-click on any part of any frame to locate the transport to that exact position. 

 Left-click on any part of any frame to locate the transport to the start of that frame. 

 Drag the scroller left or right to move the transport. 

Note: there is no zoom control on the video scroller. 

Editing the Video Track 

Selection 

Selecting the video track can be done with the mouse. To do this, click on the V symbol at 
the left of the video track. You can also use the keyboard shortcut ~ to toggle the Video track 
selection on and off. 
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Double-clicking will make it the only selection. 

 

Using the Edit Tools 

Editing tools can be used with the video track, the same way as they are with audio. The 
copy and cut commands can be used as with audio to put video clips on the clipboard, but 
unlike audio clips, they can only be pasted back to the video track. 

NOTE: Cross fades between two video clips become dissolves. 

Audio tracks and the video track can be selected and edited simultaneously. 

Editing is described in detail in Chapter 8. 

Editing with the Mouse 

Video clips can be dragged left and right, but not up and down (across tracks). 

Click Here. 

Video track is shown 
selected. 
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Watermarking 

 

Watermarking allows you to superimpose a graphic design with partial transparency over 
your video file, either on capture or while playing. If you capture the file with the watermark, 
it is permanently written into the video file. 

Controls for watermarking are found in Setup  General Preferences on the Watermark tab. 
This tab is present if a Decklink video card is present and active. See your Fairlight distributor 
for information about video cards. 

Choose the bitmap you wish to superimpose by typing its name in the Bitmap field, or by 
pressing the Browse buton. 

Selecting the movement checkbox causes the watermark bitmap to periodically move on the 
video output. The direction of the movement is specified with the pulldown, with choices: L-
>R, R->L, Top->Bottom, Bottom->Top 

Selecting the dynamic checkbox causes the watermark bitmap to periodically turn on and off. 
The time for each cycle is specified. 
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Using Pyxis Track as a Machine 

Selecting Pyxis Track as one of your machines allows you to take it “offline” the same way as 
physical machines. For information about setting Pyxis as a machine, see Chapter 22  – 
Machine Control 

For information about editing with machine control, see Chapter 8 – Editing . 
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Chapter 6 -  Audio Recording 

Introduction 

Pyxis G2 can record up to 64 simultaneous tracks to disk. The following chapter describes 
how to configure and then record audio into the system.  

Project Set Up 

 The steps for setting up a new project are described in Chapter 3 – Projects. 

Sync Setup  

The current sync setup can be changed at any time by selecting  
View  Smart Pane  Setup, or by pressing the Sync Setup button in the Setup 
Megamode. 

 
Sample rate The system supports sample rates up to 192 kHz. This is set 

when a project is created, and cannot be changed thereafter. 

Frame Rate The value you place here can be changed in the Sync display 
at any time afterwards. It should match the incoming 
timecode format for correct synchronisation. 

Bit Depth The system supports sample depths of 16 or 24 bits. You can 
change this value at any time, affecting subsequent 
recordings. All previously recorded audio is played back at its 
recorded sample depth. Note that 20-bit recording, which was 
supported in earlier Fairlight products, is no longer a choice. 

Clock Sync Source Choose the clock signal to be the master time reference for 
the system.  
Choices are: 
SX-20 Internal – uses the internal clock of the SX-20 
SX-20 Video – uses the video input signal coming into the SX-
20 
SX-20 WCLK – uses a WCLK signal coming into the SX-20 

Project Frame Rate 

The frame rate (timecode format) can be changed at any time, but should be set to the local 
standard, or to match the format of the video material or project currently being worked on.  

Step 1 Press the Setup key. 

Step 2 Press the TC FORMAT soft key. 

Step 3 Turn the jogger wheel to select the desired timecode format. 

Select Non-Drop or Drop-Frame (if applicable). 
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Step 4 Press Enter. 

Setting Frame Rate using the mouse: 

Step 1 From the View menu select Smart Pane, then Sync Setup 

Step 2 Click in the Frame Rate drop list. 

Step 3 Select the desired frame rate, including Non-Drop or Drop-Frame (if applicable) 

Patching Inputs to Track Feeds 

A track cannot be armed unless it has an audio signal patched to its input. 

Patching is described in detail in Chapter 7 – Patching and Assignment.  

Input Gain and Phase 

This is described in detail in Chapter Blah – Patching and Routing. See Input Gain and Phase. 

Arming Tracks 

Arming Tracks with the Mouse 

A track may be armed by clicking on the disk at the left of the Track Selection Panel. 

 

Arm on the Fly  

Normally tracks are armed before you put the system into record, but it is possible drop in or 
out of record on specific tracks while the system is recording by arming on the fly. 

Metering Input Levels 

The input levels to the armed tracks are shown as vertical bargraphs at the top of the screen. 
For tracks that are not armed for record, meters show the playback levels.  

Click here to 
arm Track 4 

Click here to 
disarm Track 2 
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Recording  

Step 1 Locate the transport to where you want to start recording, then click RECORD. You 
can also punch into Record while playing. 

Step 2 Click STOP or PLAY to end the recording. You can also stop recording on a track by 
disarming it. 

Recording Types 

Recording has two types: NEW and TAPE.  

New is always non-destructive, creating new data and clips. This is the most common mode. 

Tape Mode recording allows replacement of existing audio data while recording. It is 
described in a later section of this chapter. 

Monitoring Inputs 

Two input monitoring modes are available: Input and Auto. They cover different recording 
requirements, as shown below.  
 REW FF STOP PLAY REC 

INPUT Input Input Input Input Input 

AUTO Input Input Input Track Input 

To toggle input monitoring between Input and Auto, click the Input/Auto button. 

 

These settings support the following example applications: 

 {INPUT}: The track feed always monitors input. Use INPUT when the studio 
monitoring is fed through headphones, or when recording from tape and the desire is 
to punch in, cued from source material rather than playback material. 

 {AUTO}: The track feed monitors the input on record and track on playback. Use 
AUTO when the studio monitoring is fed through cans for voice-over recording or 
over-dubs. Choose {AUTO} to allow cueing from the track then switching to the 
microphone during a record drop-in. 
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Punch In / Punch Out 

It is possible to enter record while playing back from disk on Pyxis G2.  

While playing, start recording by pressing the RECORD button. To drop out of Record, press 
the PLAY, STOP, JOG, REW or FF buttons. 

You can drop in or out on individual tracks whilst recording by pressing the track keys, whilst 
the Arm menu is active. 

Each time you enter Record (in New mode) you will create a new clip on each armed track. 
These clips are placed over any other clips that they encounter on the same tracks. The 
monitoring switches from recorded material to live as you enter Record, exactly as though 
you were erasing the existing audio. 

By enabling Display Layering in the View Menu, you can see the layers of clips on each 
track. A clip can be lifted in the layer order by clicking on it with the mouse and dragging 
upwards. 

Tape Mode 

When Tape Mode is selected, you can punch in on existing Tape Mode clips and replace the 
audio media. This can save filling up disks with unwanted material, and results in a cleaner, 
simpler project with fewer clips. 

To enter Tape Mode use Process  Tape Mode  Tape Mode 

 

Using Tape Mode 

If you punch into record over an existing Tape Mode clip (shown yellow) its media will be 
replaced as you record. If you continue to record past the end of the clip, it will be extended. 

If you punch into record in empty track space, or over an Edit Mode clip (shown red or blue) 
the system will create a new Tape Mode clip without affecting the Edit Mode clip. 
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Creating Tapes 

If you would like to ensure that only one clip per track is created by recording, you can start 
by making a Tape across the whole length that you are recording. This means making a Tape 
Mode clip on each track. Having selected Tape Mode in the previous step: 

Step 1 Use the From and to buttons in the top left corner of the screen to make a range that 
represents the length of the Tape you want to make. 

Step 2 Arm the tracks where you want to put a Tape Mode clip. Now you have two choices: 

Step 3a Use Process  Make Blank Tape button to make a blank (zero waveform) Tape 
Mode clip on each armed track, filling the range. 

Step 3b Use Process  Make Tape button to make a single Tape Mode clip on each armed 
track, copying all the audio that is already in the range on the armed tracks. 
Afterwards you can replace any parts that are not correct by recording over them. 

Both Make Blank Tape and Make Tape run quite fast – about 10 seconds for each hour of 
track time. The advantage of using them is that you do not need to record sequentially – you 
can move around anywhere in the Tape and replace the parts you are ready to work on. 

Automatic Drop-in 

Pre-determined drop in and drop out points may be activated using a range as follows.  

Step 1 Make a range using the From and to buttons. 

Step 2 Click the Record Range button in the Record Megamode 

The transport will preroll the IN point, punch into record, and punch out at the OUT point. 

The Preroll and Postroll times are set in the ADR menu, which is accessed via the Tools 
megamode. 

See Chapter 15 – ADR for more advanced recording options.  
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Chapter 7 - Patching and Assignment 

Introduction 

Before any recording, editing or mixing can be performed on Pyxis G2, the system must be 
configured. 

Setting up Your Control Room Monitors 

If this is the first time your Pyxis G2 has been used you will first need to set up and patch 
your control room monitors. See “Monitoring” on page 123 for instructions on patching and 
using your monitors with Pyxis G2. 

Some Terms 

Patching 

Patching means connecting signal paths – the output of one to the input of another.  

It is accomplished using the Patch I/O screen, which is accessed from the Patch I/O button 
in the Record and Setup megamodes. 

Assignment 

Assignment means sending signals to Monitor Buses, where they can be heard. This is 
accomplished in the Assign screen, which is accessed from the Monitor Assign button in the 
Setup megamode. 

Using the Patch I/O Screen 

The following basic steps are used to patch any signal to any other. 

Step 1 Press the Patch I/O button in the Edit Toolbox.  

 

The system displays the Patch I/O screen. 

Step 2 Select a Source (see below). 

Step 3 Select a destination (see below) 
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Step 4 Click the Patch button on the screen. 

The Patch I/O Screen 

All patching operations can be carried out on the Patch I/O screen, which is used to represent 
the physical inputs, outputs and signal paths being patched together. This is automatically 
shown when the Patch I/O button is pressed. You can force its display by holding down SHIFT 
and ctrl then typing P. 

Sources are shown on the left of the screen, while destinations are shown at the right.  

 

Source Categories 

Categories of signal paths are selected in the lower part of the screen. 

Source categories 

Sources 

Destination categories 

Command 
Buttons 

Destinations 
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Selecting a category of sources expands the category in the upper left of the screen. 

 

In this case Analog Inputs have been selected. 

Destination Categories 

 

Selecting a category of destinations expands it into the upper right of the screen. 

Source categories 

Destination categories 
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In this case Track Inputs are shown. 

Making a Patch 

 

Select a source and a destination then click the Patch button in the center. 

 

Afterwards the tiles used in the patch will show the results. Source is always shown above 
destination. 

 

 

 

                     

                                 

Notes: You can select multiple sources and multiple destinations and patch them all with one 
command. For example, select Analog Inputs 1 to 8 and Track Inputs 9-16, then click the 
Patch command once. 

To deselect all the signal paths you have selected, touch the Clear button. 

The Multi Button 

Clicking the Multi button allows you to patch the same sources multiple times. 

Source 

Destination Source 

Destination 
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Normally after a patch, both sources and destinations are deselected, but if Multi is ON, the 
sources remain selected through as many patchings as you like. 

View Buttons 

 

The View buttons control which names appear on the tiles. 

If you choose View System, the names shown are the functional system names like Track 5, 
Live 3 etc. 

If you choose View User, the names will be the ones you have given to these signal paths. 
For signal paths where you have not given a name, the system name is used. 

The Info Button 

 

Pressing the Info button allows you to see more detail about specific tiles. To do this, press 
Info, then click on any tile. The system will show a box with information about the source and 
destination patching associated with that tile. 

What are the Categories? 

Each category name has two parts. The first part can be  
Track – a recording track  

Live – a Live Feed, which is a full-featured channel bringing audio directly to 
a bus 

Main – the Main mix bus 

MT-Bus – a Multi-track bus, as used in traditional mixing systems 

Sub-Bus – a multi-Element bus used for extra mixing functions 

Aux-Bus – a mono or stereo bus, tied to the Auxiliary sends on the channels 

Mon – shows the elements of the Control Room and Studio monitor paths 
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Analog – an analog physical input or output 

Digital – an AES-EBU physical input or output 

MADI – a MADI physical input or output 

Osc – the system oscillator and noise generator 

The second part can be: 
In  – the input of a signal path (not a physical input) 

Out  – the output of a signal path (not a physical output) 

Direct  – each signal can have a Direct Output 

Send  – Insert Send from a signal path 

Return  – Insert Return to a signal path 

Talkback  – the Talkback system – shows Comm1 and Comm2 

Inputs  – physical inputs (analog or digital) 

Outputs  – physical outputs (analog or digital) 

So, for example Analog Inputs means the physical analog input ports, while Aux-Bus Send 
means the Insert Sends from the Aux Busses.  

Input Gain and Phase 

Analog and Digital inputs can have digital gain or attenuation, and phase reversal applied at 
the input. Inputs are selected by first selecting the signal paths that they are patched to. 

There are two ways to set input gain and phase. You can use the mixer screen or the track 
keys. 

Patching One Input To Multiple Signal Paths 

It is possible to patch the same physical input to many different tracks, and record any that 
you wish at the same time.  

Unpatching Inputs 

To remove input patching from a set of one or more tracks, press the Patch I/O key, select 
the tracks and click the Remove button. 

Patching Monitor Outputs 

Physical outputs can be patched from the Monitor Outputs. To do this: 

Step 1 Press the Patch I/O button in the Edit or Setup megamode. The system displays the 
Patch I/O screen. 

Step 2 Select CR-Mon Out as your Source 

Step 3 Select Analog Outputs (or Digital Outputs if appropriate) as your destination 

Step 4 Select one or more of your Monitor Elements (Left, Center, Right etc) and the same 
number of physical outputs. 

Step 5 Click Patch 

Step 6 Repeat steps 4 and 5 until you have what you want. 
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Step 7 Close the Patch I/O page by clicking its Close Box, right-clicking anywhere inside it, 
or pressing the Escape key on your QWERTY. 

Oscillator 

Dream II provides an on-board digital oscillator for system calibration, slate line up tones, 
and path identification. The oscillator may be fed to any track. 

Using the Oscillator 

Step 1 To turn the Oscillator on and off, Blah 

Oscillator Frequency and Level 

Step 1 Blah 

Patching the Oscillator 

The oscillator may be patched to any track. This is done on the Patch I/O screen. 

Step 1 Press the Patch I/O button in the Edit or Setup megamode. The system displays the 
Patch I/O screen. 

Step 2 Select Osc as your source category. 

Step 3 Select the OSC button to patch the oscillator (or Noise to select the noise generator). 

Step 4 Select one or more Tracks on the right side of the page. 

Step 5 Click the Patch button. 

The Noise Generator 

The oscillator is closely allied to the noise generator. When patching the noise generator to a 
source in the Patch page, start by selecting Osc, then choose Noise. 

 

Level control for the noise generator follows that of the oscillator, set in the Utils 
Menu. The setting for white or pink noise is also found here. 
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Chapter 8 - Editing 

Introduction 

Pyxis G2 offers simple mouse-based editing. 

Edit Modes 

The main editing actions are performed in five modes that can be selected on the Tool Bar. 

 

Copy copies the selection to the clipboard (Enter pastes it into the tracks) 

Cut cuts the selection to the clipboard (Enter pastes it into the tracks) 

Erase erases the selection. 

Trim retracts or extends the heads or tails of clips. 

Fade fades or cross-fades the selection. 

Once a mode is selected, it remains current until another mode is selected. 

The Cursor 

Most edits are performed at the Play Head or Cursor. This is the vertical line in the center of 
the Track Display. 

 

Normally the Cursor is stationary, and the clips scroll across the tracks. The audio you hear is 
the waveform passing the Cursor (hence its name – Play Head). 

Moving Cursor 

Many products show stationary waveforms with a moving cursor. To show this in Dream II, 
select Setup  Locked Playhead from the menu bar. 

When this item is ticked, the cursor is stationary, but otherwise it moves. 

Cursor 
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While the cursor is moveable, you can reposition it by right-clicking anywhere in the Edit 
Screen and dragging the mouse right or left (audio is not played while you do this). 

When re-locking the cursor, its current position is held. This allows you to place it away from 
the middle of the screen, which can be useful for seeing more of the incoming audio, for 
example. 

Cut and Paste  

Whole Clip 

To cut and paste a clip: 

Step 1 Select a track and move the transport so that a clip is under the cursor. 

 

Step 2 Click the Cut button on the Tool Bar (if not already selected). 

Step 3 Click the Clip button 

 

 Step 4 Select another track (and/or move to another location) 

 

Step 5 Click the Paste button to paste the clipboard. 

The clip is red because 
it is touching the 
cursor. 

We see the clip’s “ghost”. 
It’s a picture of the 
clipboard ready to be 
pasted in. 

The ghost shows where 
the clipboard contents 
can be pasted. 
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Head 

This time we’ll only work with the Head of the clip. That is the part before the cursor. 

Step 1 Select a track and move the transport so that a clip is under the cursor. 

 

Step 2 Click the Cut button on the Tool Bar (if not already selected). 

Step 3 Click the Head button 

 

Step 4 Select another track (and/or move to another location) 

The clip is pasted. 

Only the head goes on 
to the clipboard.  

The clip is red because 
it is touching the 
cursor. 
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Step 5 Click the Paste button to paste the clipboard. 

 

Range 

You can make a range that specifies exactly which part of the clip is affected. The easiest 
way is like this (more about ranges later): 

Step 1 Move the transport where you’d like to start the range. 

Step 2 Click the From button 

Step 3 Move the transport where you’d like to end the range. 

Step 4 Click the To button 

 

Now we’ll cut and paste the audio in the range. 

Step 1 Choose the track and set the range (we’ve just done this) 

Step 2 Click the Cut button on the Tool Bar (if not already selected). 

Step 3 Click the Range button 

The ghost shows a head-
shaped clipboard ready to be 
pasted. The original tail is now 
Blue, because its track is not 
selected.  

The clipboard (former 
head) is pasted. 

The range is marked in 
red. 



Operator Reference Manual  CHAPTER 8 - EDITING September 15, 2011 
 

Pyxis G2 Page 66 

 

Step 4 Select another track (and/or move to another location) 

 

Step 5 Click the Paste button to paste the clipboard. 

 

Notes about Cut and Paste 

Tail 

Works the same way as Head, but cuts the later part of the clip 

Range and Head 

When a range is active, Clicking the Head key cuts the audio from the start of the range to 
the cursor. This will not work if the cursor is not in the range. 

Range and Tail work similarly together. 

Multiple Clips and Tracks 

When there is no range, the target for editing is all the clips on selected tracks that are 
touching the cursor. It’s easy to tell which, because they are always red. 

The audio in the range 
is moved to the 
clipboard. We see the 
ghost. 

The ghost moves to the 
new track. 

The clipboard (former 
range) is pasted. The 
range persists after the 
edit. 
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When there is a range, the target is all the clips (and parts of clips) on selected tracks that 
are inside the range. Again, the target clips are always red. 

An exception – with a range you can use the mouse to deselect a clip. To do this, hold down 
the Ctrl key and click with the mouse. The clip will turn blue, showing that it is no longer 
selected. 

You can also extend the selection using Ctrl-mouse-click on a clip. This will cause the 
range to expand so that it includes the newly selected clip, and it will preserve the existing 
selection as well. 

Pasting 

Pasting the clipboard (use the Paste button) means putting a copy of it at the current 
position, on whatever tracks are selected. 

You can paste the clipboard contents at any time, not just after a cut operation, and as often 
as you like.  

If there are already clips at the place where you paste, the clipboard is placed “on top” of the 
existing clips. Only the top layer is heard, unless there is a crossfade between layers (more 
about that later). 

The “shape” of the clipboard’s track selection is preserved when pasting, regardless of track 
selection at that time. For example, if you copy clips on tracks 1 and 3, then select only track 
8 and click Paste, the clipboard will be pasted on tracks 8 and 10. The first track on the 
clipboard is always pasted on the lowest-numbered track in the selection. 

Variations 

There are a few extra keys which change the functions of Cut and Paste. 

All Layers 

Sometimes clips are stacked in layers. Of course we only hear the top layer, or crossfades 
between the top and second layers (more about crossfades later). 

You have the choice of cutting only the top layer, or all the layers. The All Layers 
command controls this choice. When it is on, you will cut all the layers, and they’ll be placed 
on the clipboard, ready to be pasted. When it is off, you will cut only the top layer. 

To turn on all layers, use the menu command: 

Edit  All Layers 
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Hint: if you want to see all the layers, select Edit  Display Layering. 

Razor 

Sometimes it is useful to cut the time out of a track, not just the audio. This is similar to 
cutting tape. 

To cut time as well as audio, turn on the Razor button. This will automatically turn on Range 
and All Layers. 

As soon as you cut something (Head, Tail or Range) the time they occupied is also cut, and 
all the following clips move earlier. 

When you paste (click Paste) with Razor switched ON, the clipboard audio is inserted into 
the track, pushing all the following clips later. This is true even if Razor was not ON when the 
clips were cut to the clipboard. (Cut and Paste are really independent commands, each 
responsive to the Razor setting.) 
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Copy 

Copy works exactly the same way as Cut, except that the audio is not removed to place it on 
the clipboard, only copied. Pasting after copy is the same as after cut. 

Erase 

Erase works exactly the same way as Cut, except that the audio is not placed on the 
clipboard. 

The clipboard remains unchanged, so its previous contents are ready to paste at any time. 

Extra Edit Commands 

The following extra buttons are available when the Cut, Copy or Erase modes are current. 
split clip Cuts the clip into two pieces at the cursor position. 

mute clip Silences the clip 

cleave clip Removes the link between stereo linked clips. 

reverse Creates a reversed version of the audio in the selected clip(s) and 
replaces the original with this reversed version. 

Paste Special 

Instead of pasting the clipboard contents at the cursor position, it is possible to paste 
characteristics of a clip into other clips.  

Step 1 Copy some clips to the clipboard using the Copy menu, the mouse, or the keyboard 
shortcut (ctrl+c) 

Step 2 Select the destination clips for the paste. They can be on multiple tracks and may use 
a range. You may select All Layers, or only the top layer. 

Step 3 Click and hold the command Edit  Paste Special 

The system displays this dialog: 

 

Step 4 Now choose which characteristic to paste. 

Notes: 

 The clip whose characteristics are copied is the earliest (in timecode) on the lowest 
numbered track copied to the clipboard. 

 The special paste targets every clip that is wholly within the range, on selected 
tracks. 
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Trim 

Trimming allows clips to be resized. Trim commands are used to set the head and tail of clips, 
to determine how much of the original recording is played by the clip. 

Trimming may shorten a clip, or extend a clip if it is playing less than all of the original 
recording. This will be the case if the clip was imported with handles or if the original clip has 
been edited. 

Head 

Trim Head and Trim Tail are the most common uses of Trim 

Step 1 Select a track and move a clip under the cursor. 

Step 2 Press the Trim key on the  (if not already on) 

Step 3 Press and release the Head key 

Step 4 Move the transport forward a few frames (jog or play) 

Step 5 Press Enter 

The head of the clip is placed at the cursor, which is now shorter. The effect is just like 
erasing the head of the clip. Its sync remains as before, but it starts at a later time and a 
later point in the audio. 

Step 6 Jog backward a few frames and press ENTER 

Now the head is moved earlier, revealing more of the audio. You can keep jogging and 
pressing ENTER as long as you like, until you are satisfied with the position of the head. 

Limit to Trim 

When extending a clip, the end of the recorded audio will be reached eventually. After that it 
is not possible to extend the clip further. 

Tail 

Same as Head, but the later part of the clip is trimmed. 

Range 

Ranges cannot be used with Trim. 

Multiple Tracks 

Works as expected. All the red clips will be trimmed to the same point in time. 

Soft Keys in Trim Mode 

{sync point} Pressing the {sync point} soft key creates a sync marker within the selected 
clip(s) at the cursor position. This is shown as a yellow mark in the clip, and 
can be used to visually locate an important moment. 
To change the sync point, press {sync point} at the new location. There is 
only one sync point per clip. 
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Trim Edit Options 

Trim is usually applied to a single clip or selections across tracks therefore, no options are 
available. 

Range On is not supported in Trim Mode. 

All Layers On is not supported in Trim Mode. 

Razor On is not supported in Trim Mode. 

Nudge 

The Nudge function slips clips by one frame in either direction. Nudge can operate on one or 
many tracks affecting clips that lie under the cursor, or within a Range. 

Using Nudge 

Step 1 Press the Nudge button. 

Step 2 Locate the cursor over the clips and select the appropriate track(s). 

Step 3 Press the Nudge Left or Nudge Right button to slip the clip(s) by one frame.  

 

When there is no Range, only the top layer of clips highlighted under the cursor is 
nudged. 

Nudge with A Range 

Follow these steps to perform a NUDGE with a range selected:  

Step 1 Press the Nudge button. 

Step 2 Use the From and To buttons to select a Range that includes all clips to be nudged. 

Step 3 Press the Nudge Left or Nudge Right button to slip the clip(s) by one frame.  

When a Range is selected, all layers of clips within the Range are nudged, including 
those which are completely buried. 

NOTES: 

Nudging is possible while the transport is in play. 

When nudging a Range, clips not wholly within the Range are not affected. However, the 
Range itself is also nudged, so it is possible to keep nudging the Range without resetting the 
From and To points.  

Snap Editing 

Snap Editing can be turned on from the Edit Menu. You can then choose what you would like 
clips to snap to when arranging your clips on the timeline. This can speed up operation 
considerably depending on the nature of the project 

Nudge Right 

Nudge Left 
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Fade Mode 

The Fade key on the  allows fades to be applied non-destructively to the heads and tails of 
clips. The fades are performed by the system in real time as the audio is output from the 
machine. Fades can be created “on the fly” relative to the playhead, or they can be created 
and/or modified on multiple clips at once. 

Fades can be applied from the Tool Bar buttons, and from the PC screen. 

The Editing screen displays fade information in the Smart Pane at the top of the monitor. This 
is used to issue commands as well as illustrate fade shapes (curves). 

Using the Tool Bar 

 

Fade Head 

One of the simplest fades can be achieved as follows: 

Step 1 Select a track and move a clip under the cursor. 

Step 2 Click the Fade button (if not already on). 

Step 3 Click the Head button. 

This creates a fade from the start of the clip to the cursor position. The shape of the fade can 
be seen above (this will be described later), but the Duration is not used. Instead, the 
duration is set by the cursor position. 

If you are happy with your current fade shape, using Fade Head is a fast and simple way to 
get a lot of work done. 

NOTES:  

 If you do not want to apply the Smart Panel shape shown above to the Head, turn off 
the Shape checkbox in the Smart Panel. 

 If you ONLY want to apply the shape, and not to change the length of the head fade, 
turn off the Length checkbox. 

Snap to other clips edges 

Snap to other fades 

Snap to markers in your project 

Snap to sync points in clips 
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Fade Tail 

Same as Fade Head, but it fades from the cursor to the end of the clip. 

Fade Clip 

Applies the numbers in the Head Duration and Tail Duration fields, shown in the Smart Pane. 

 

Using Multiple Tracks 

If multiple tracks are selected, the simple Fade Head and Fade Tail commands will apply to all 
clips touching the cursor on selected tracks. 

Using a Range 

If a Range is present, the Fade Head command applies the Head Duration field value, and the 
Fade Tail command applies the Tail Duration field value, to all red clips (those wholly inside 
the range on selected tracks). 

Using the Smart Panel 

While the Fade mode is active, the screen displays shapes and controls for creating and 
editing fades. 

Fade Head 

Step 1 Select a track and move a clip under the cursor. 

Step 2 Click the Fade button (if not already on). 

Step 3 Click the Head button in the screen display (it’s near the upper right). 

Step 4 Adjust the shape of the Head fade (described below). 

Step 5 Click the Apply button. The fade described in the shape is applied to the head of the 
clip.  

Note that the fade duration is set by the cursor position, as when using the Tool Bar 
commands. 

Length and Shape 

The Length and Shape tickboxes allow you to choose what to apply. You can untick the 
Length tickbox if you only want to apply the shape, and vice versa. 
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Fade Shape 

Using the mouse and screen method allows you to set the fade shape before applying it. The 
shape includes the following parameters: 

Percentage (X-Point) – this controls the percentage of the fade’s duration when it reaches the 
Crossover Point. 

Attenuation (X-Level) – controls how loud the fade is (compared to the full Level of the clip) 
at the Crossover point. 

Duration – the total length of the fade, in frames. (Duration is not really part of the shape, 
but its control is close by). 

Example: Percentage = 30%, Attenuation = -3 dB, Duration = 20 

This means that the fade will last for 20 frames. The crossover point will be 6 frames into the 
fade, at which time the level will be -3 dB compared with full Level. 

NOTE: The fade shape can be changed directly with the mouse, by dragging on the red 
buttons in the graphs. 

Fade Tail 

Same as Fade Head, but the fade is applied to the end of the clip. 

Fade Clip 

If both Head and Tail are selected when you click Apply, both ends of the clip can be faded at 
the same time. 

Using a Range 

If a range is present when the Apply key is clicked, all clips that are wholly inside the range 
will be affected by it. 

Fade Presets 

The system provides nine convenient fade shapes as presets. These can be recalled instantly 
by clicking on the keypad at the left. Having recalled a preset, it can be applied to the Head 
and/or Tail of the currently selected clips using the Apply button.  

Presets 

A preset is a saved shape for head and tail. Factory presets are provided for your use. 
Custom presets are saved by you. 

To load a factory preset, press the {Preset} soft key, then press keys 1-9 on the numeric 
keypad to choose one of the 9 factory fade presets. The preset is loaded into the Shape 
graphs, and can be applied to clips in the usual way. Alternatively, click a number in the 
preset pad at the left of the display. 
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To load a custom preset, use the custom presets pulldown menu in the Fades 
display. 

 

To save a custom preset, use the custom presets pulldown menu in the Fades 
display, as shown above. Type a name into the field and click Save. 

Capturing Shapes 

To capture a fade means to extract all of its parameters, making them available to apply to 
other clips. 

Step 1 Click the capture button. This will cause it to flash. 

Step 2 Click the Clip, Head or Tail button to capture the fade length and shape from the 
current clip. The current clip is the one currently touching the play head on the active 
track.  

Having captured those values, you can apply them to any other red clip by clicking the Clip 
button. Untick shape or length if you don’t want to apply it. 

Cross-Fades 

If a fade is placed on a clip and there is another clip layered underneath, a cross-fade 
between the two will automatically be “induced”. Cross-fade parameters can be modified with 
the soft key menu functions. 

Induced crossfades are complementary – that is to say, the clip underneath is faded with 
exactly the opposite shape to the clip on top. 

If the clip underneath already has its own fade, overlapping the time of the upper clip’s 
crossfade, then no induced fade occurs. In the following illustration, clip layering has been 
turned on (using BLUE Track or View>Display Layering). 

Click to load a factory preset 

Click to load a custom preset 

Click to type a new name for a 
custom preset, then click Save 
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Induced crossfade – note lower curve No induced fade – lower fade overlaps 

Fade Options 

Layers On 

ALL LAYERS ON is not supported in Fade Mode. 

Razor On 

RAZOR ON is not supported in Fade Mode. 

Soft Edit 

Every clip has a small fade at the head or tail to make it sound smoother. This is called a Soft 
Edit, and you can control its length. To do this, click the Setup Menu on the Track screen and 
select General Preferences. In the dialog that is displayed, click the Playback tab. 

Step 1 Click the Setup Menu on the Track screen 

Step 2 Select General Preferences. 

Step 3 Click the Playback tab. 

Step 4 Change the value for Soft Edits 

The current value for Soft edits is shown in the Audio Options group. A value of 72 samples is 
generally useful when the Project sample rate is 48 kHz, but you may set this according to 
your own taste. 

Creating Smooth Level Changes 

By pasting a copy of a section of a clip onto itself, you are able to change the level of the 
copy to create a level change. If the copy is cross-faded with the original, a smooth level 
transition results. When using the COPY and PASTE functions, be sure to be in STOP otherwise 
a slight movement of the jogger wheel may result in phasing during the fades. 

The same technique can be used to fade one clip EQ setting to another, within the same 
piece of audio. 
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In the above illustration, the top layer plays the same audio as the bottom layer, but may 
have different level or EQ settings. During the fade-in and fade-out, the settings will 
effectively crossfade. 

Editing on Multiple Layers 

Clips in Pyxis G2 form layers on each track, with the most recently pasted or recorded clips 
sitting “on top” of the others. During playback and record, only the top layer is heard, or a 
crossfade between the top and second layers. 

 

In the above example, the sections that are played are indicated in red and orange (this is 
just indicative, not part of the user interface). The orange sections form a crossfade between 
the top and second clip in the stack. 

This layered view can be toggled on and off using the command View  Display Layering. 
Many editing functions target only the top layer, and some target all the layers, as explained 
previously. To access a particular clip below the top layer, we use the mouse. 

You can lift or lower any clip from layer to layer by clicking and dragging with the mouse. In 
addition the command Edit  Rotate sends the top clip to the bottom. 

Importing Clips from Other Projects 

A library project is any other project that you wish to use as a source of clips. 

The clips continue to reference the same media files as they did in their original project. 

To import clips from another project, do the following: 
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Step 1 Use the command File  Open Library 

Step 2 Choose a file from the Open dialog and click OK.  

This opens the Library File (i.e. the one from which you will import) 

Step 3 Move around the Library File and locate the clip(s) you want to import.  

You can use a range or not, and select one or more tracks. The targeted clips will be 
red. 

Step 4 Click the Copy button in the Edit megamode. 

This will copy the targeted clips to the clipboard. 

Step 5 Use the command File  Close Library to return to your project. 

Step 6 Locate to the position where you want to paste the copied clips, and click Paste. 

The clips are pasted. If you want more clips from the same project, use the 
command File  Open Recent Library to see a list of all the libraries you have used 
in the current session. 

The clips will be sample rate converted on import to match your current project. 

Gating Clips 

A rough but useful and quick way to remove unwanted silence or near silence from clips is 
with the Gate Clips function. 

Using the Gate Clips Function 

First you will need to select one or more track(s) and select the clip(s) you want to gate, 
either by selecting a range or by parking the playback head over the desired clips. You are 
now ready to perform the Gate Clips function. To do this: 

Step 1 Use the menu command Process Gate  Preview. 

Step 2 Your selected clips will now be shaded in grey. The grey areas mark the audio that 
will be retained after the Gate Clips operation is performed. Start by moving the 
“Threshold” slider slowly to the right. 

Step 3 Depending on the type of audio contained in the clip, areas will begin to be shaded in 
pink. This indicates the areas that will be removed when the Gate Clips function is 
performed. 

Step 4 Once you have adjusted the threshold so that the undesired portions of the clip are 
highlighted in grey, adjust the hold time and pre handle time to fine tune the gating 
process(see below).  

 

Pink indicates where the gate is open i.e. where audio will be retained. 
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Threshold defines the level above which the gate is open. 

Tail Handle defines how long the Gate remains open after the audio level falls below 
the threshold value. 

Head Handle defines the time the gate opens before threshold is reached 

Step 5 When you are happy with the amount retained versus the amount removed from the 
graphic representation, click the “Gate” button to process your settings. All grey 
areas in the clip will be removed, retaining the pink areas. 

NOTE: As with many other editing functions in Dream II, the original audio is not affected by 
clip gating, only the clips that reference it. Any audio removed by gating can be 
recovered using the Restore Head and Restore Tail functions under the Edit menu. 

Replacing Audio Media 

As mentioned elsewhere in this manual, a clip is a “reference” to a piece of media on disk. 
Editing the clips is non-destructive to the media – it simply changes the portion of the media 
being played by the clip. 

Sometimes it is also valuable to change the media played by a clip. This can be done in two 
ways: 

 Replace the media of the selected clips 

 Replace the media of all project clips using a particular piece of media at the moment 

Step 1 Select one or more clips by the usual methods. You can use All Layers to affect the 
clips on all layers, and you can use a Range to select multiple clips horizontally – in 
this case only clips lying entirely inside the range will be affected. 

Step 2  Issue the command Process  Change Media – Selected Clips 

The system displays a dialog where you can browse for a media file. 
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Step 3 Browse to find the media you want, and click the Open button. The system replaces 
the media in the selected clips. 

To replace the media of clips using that media file, do the same as above, but use the 
command Process  Change Media – All Related Clips  

Undo and Redo 

If en edit function has been performed that you are not happy with, clicking the Undo button 
or using the command Edit  Undo will revert the project to its state before the undesired 
edit. Afterwards, Redo will reinstate the edit. 

Undo List 

In the Edit Menu, there is an undo list showing all undoable functions which you have 
performed in your current session. You can choose one of these operations to undo, but be 
warned it will also undo all operations you have performed since the operation you chose to 
undo to. 

Undo Follow 

By default, when you undo an edit, the system returns to the position and view from which 
the edit was performed. This can make it easier for you to correct that particular edit. If you 
don’t want the system to follow, you can turn it off as follows: 

Step 1 Use the command Setup  General Preferences 

Step 2 Click the Project tab 

Step 3 At the bottom of the dialog, check the Playhead Follows Undo and/or Zoom follows 
Undo controls 
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Direct Mouse-Based Editing 

The mouse can be used to select clips, make ranges and move clips in time and across 
tracks. This can be done irrespective of which editing or mixing mode is selected. 

Selecting Clips 

As explained previously, the mouse can be used to select and deselect individual clips within 
the range, by Ctrl-clicking on them. If no range is present this can still be done. When you 
Ctrl-click a clip when no range is present, a range will be created which includes all the 
previously selected clips, plus the one just added. If the track containing the clip was not 
selected, it becomes selected automatically. 

Mouse-Based Ranges 

The mouse can be used at any time to create a range. Simply click an empty space (one 
where there is no clip) and drag an area on the Track display, and a range will be created. 

At the same time, any clips or parts of clips on already selected tracks, that are inside the 
area you dragged, will be selected. All other clips will be deselected. 

Selecting clips when creating a range with the mouse does not select tracks, but selecting 
clips by directly Ctrl-clicking them does select tracks. 

To remove the current range, click (but don’t drag) anywhere with the mouse. 

Moving Clips 

Clips can be dragged horizontally and vertically with the mouse. This changes the clip 
timecode and track respectively. 

When there is no range, simply click and drag any single clip to another time or track. 

When there is a range, click on any selected (red) clip and drag it – all other red clips will also 
be dragged along with the one you clicked. 

Summary of Mouse Editing Actions 

Action Result 

Click on unused trackspace Removes range 

Click on a clip Selects the track containing the clip 

Ctrl-Click on a clip If unselected, adds it to the selection (makes it 
red). Also selects its track, if not already selected. 
If already selected, removes it from the selection 
(makes it blue) 

With no range, click on a clip and drag it The clip moves to any track and time where you 
drag it. The destination track is selected. 

With a range, click on a selected clip 
and drag it 

All selected clips move across tracks and time as 
you drag them. 

Display Layering 

When clips are placed “on top” of each other, only the uppermost is heard, or at most a 
crossfade between the top and second layers. The software allows you to see all the layers 
using the command View  Display Layering. 
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The layers of clips are shown on all tracks, with the clips becoming thinner as needed to fit 
the available space. 
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The mouse can be used to change the order of clips. To do this, simply click and drag a clip 
from one level to a higher or lower level. Changing levels in this way can be combined with 
dragging a clip to a different track or timecode. 

Note that there is always a space at the top of each track, equal to the width of one clip. This 
is to allow room for you to drag a clip into the top position. 

Mouse Edit Menu 

The screen Edit Menu provides many commands that are available elsewhere in the system. 
The mouse can be used to access these commands. 
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Undoes the last edit

Redoes the last edit that was undone 

Shows a list of the edits that can be undone 

Cuts the selected clip or range to the clipboard 
Cuts the head of the clip at the cursor position 
Cuts the tail of the clip at the cursor position 

Copies the selected clip or range to the clipboard 

Copies the head of the clip at the cursor position 

Copies the tail of the clip at the cursor position 

Pastes a copy of the clipboard at the current position

Erases the selected clip or range
Erases the head of the clip at the cursor position 

Erases the tail of the clip at the cursor position 

Extends the clip head to use all the recorded audio
Extends the clip tail to use all the recorded audio 

Heals separation in audio clips

Unlinks multichannel clips

Deletes unheard clips hidden by layer(s) of other clips

Cuts the selected clips into two at the cursor 
Allows the level of selected clips to be set 
Allows the selected clips to be renamed 

Syncs the selected clips to their record timecode 

Reverses the audio in the clips

Rotate cycles clip layers around when in BLUE Takes mode

Positions the Sync point in the clip. Can be used for Jumping

Controls Range On/Off and sets head and tail of range

Controls the number of layers affected by edits 

Turns Razor edit on and off

Turns Razor edit on and off

Turns Snap Editing On or Off

Defines where clips snap to when mouse editing 
Defines Jump destination points for speedy project navigation
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Fade Menu 

Fades can be applied to clips using the Tool Bar buttons or the Smart Pane as described 
earlier. It is also possible to apply fades using the Fades Menu. 

This is located at the top of your Dream II window and looks like this: 

 

 

 

Fades to the end of the clip closest to the Cursor 

Fades to head of Clip(s) 

Fades to tail of Clip(s) 

Makes a one second overlap by pulling out the head and tail of 
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Chapter 9 - Clip Level 

Introduction 

The Level mode allows clips to be amplified and attenuated by up to 99dB. It also allows the 
displayed waveforms to be amplified and attenuated independently of the audio levels. 

The gain changes are performed by the system in real time as the audio is played out from 
the system. Applying a level change to a clip does not affect the media on disk. The level 
function can operate on multiple tracks, on clips that lie beneath the cursor and also within a 
Range. 

Applying a Level Change 

Step 1 Click the Level button. 

 

Step 2 Select the track or tracks containing the clips you wish to modify. 

Step 3 Locate the cursor over the clip(s) or define a Range that wholly contains the clips. 

Step 4 Press the Set or Trim button. 

Step 5 Change the level by typing in a value between -100 and 100 dB. If Trim was pressed, 
the amount is a level offset for the selected clips. 

To enter a negative number, type a minus first. 

You can alter the number in 0.1 dB steps using the up and down arrows on the 
QWERTY. 

Step 6 Click OK to make the change permanent, or Cancel to escape with no change. 

The output of each track is displayed on the level meters. 

Range 

A number of clips can be altered at the same time using a Range and track selection. A range 
is created using the From and To buttons  

When using a Range, only clips that are entirely within the Range are affected. 

NOTES: 

It is possible, when using the Level Menu, to push the level of a clip over digital full scale. 
Check the meters, to set the level for just part of a clip, then use the split command to break 
it into the right sized pieces, then set the appropriate levels. 

To create a ramp between different levels in one clip, first copy the section whose level is to 
be changed (using the Copy mode), then paste it back on top of its source. Change its level 
as desired, then use the Fade Menu to create fades at either end of the clip. This will cause it 
to crossfade with the source clip underneath, which will be playing at the original level. As 
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long as you didn’t move the transport between copying and pasting, phase coherence will be 
maintained during the level ramp. 

Applying a Waveform Amplitude Change 

Amplitude is changed for whole tracks, not individual clips. We refer to a track’s amplitude 
“offset” meaning the amount by which the amplitude is changed from the actual sound level 
being played by the clips on a track. 

Multiple tracks may be selected. The amplitude offsets of all selected tracks may be set to a 
fixed amount, or may be trimmed (increased or decreased) from their current values. 

Step 1 Click the Level button. 

Step 2 Select the track or tracks whose waveform amplitude you wish to modify. 

Step 4 Click the Display Set or Display Trim button. 

Step 5 Change the level by typing in a value or using the Jogger Wheel. 

Step 6 Click OK to make the change permanent. 
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Chapter 10 - Clip Equalisation 

Introduction  

Pyxis G2 provides clip based, four band parametric Equalisation (plus shelving) which can be 
applied to a single clip or range of clips within a Project. EQ is performed by the system in 
real time as the audio is output from Pyxis G2 , therefore applying an EQ change does not af-
fect the audio data on disk. 

Clip EQ is controlled from the Smart Pane. To access it use View  Smart Pane  Clip EQ 

 

Applying EQ 

Step 1 Open the Clip EQ Smart Pane (see above). 

Step 2 Locate the cursor over the clip or define a Range of clips. 

Step 3 Click the edit button. 

 

Step 4 Select the appropriate EQ parameter. 

This is done by clicking in the appropriate field in the EQ display above. 

Step 5 Adjust the parameter by typing a value on the QWERTY keyboard and pressing its 
Enter key. Changes are heard in real time. You can also use the up and down arrows 
to change values. 
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Step 6 Repeat steps 4 and 5 as often as needed. 

Step 7 Apply the changes by clicking the Apply button. 

Each equalisation band has three parameters you can change. They are: centre frequency of 
the band, gain (cut or boost) at that frequency, and Q-factor (sharpness of the band) or 
whether it is a high or low shelf. 

To change the filter type for a band, click the icon indicated below: 

 

EQ display 
 

 

Left side of display. When a clip’s EQ is being edited, the dots change from black to red (as 
shown here). They can be moved with the mouse, changing frequency and gain values. 
These values are updated in the value grid as you move the mouse. You can also hear the 
changes in the audio if it is playing, after a short delay.  

 

 
 

Range Filter Type Frequency Gain Q-Factor Enables 

Right side of display. The value grid shows the parameters of the EQ being applied to the clip 
(or range of clips). 
 

Click to cycle between Hi-Pass, 
Lo-Pass and Band-Pass filter 
type. 
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Band There are four EQ bands that you can apply. They are given 
the names commonly used on mixing consoles, but actually 
they are not in fixed ranges –  you have the full frequency 
range available on each of them. 

Filter Type Choices are: 

     Band pass filter 

    High pass filter 

    Low pass filter 

Each band can be set to any filter type. Mouse-click on the 
button to cycle amongst the choices. 

Frequency The centre frequency of each band. 

Gain The gain of the band. Range -99 to +20dB. 

Q  This displays the Q of the band or indicates the type of shelf. 
Range 0-99. 

Enables Used with the Apply command. Only the Enabled bands are 
applied to the selected clips. 

  

Value Grid 

 

The Value Grid shows all the current parameters of the EQ being changed.  

Applying the Changes 

To apply your changes, click the Apply button. Only the bands whose Enable checkboxes are 
selected will be applied. 

To escape without applying your changes, click the Cancel button. 

New or Old 

Whilst adjusting an EQ parameter it is possible to toggle between the new and old settings by 
clicking the New / Old radio buttons, until you apply the changes. 
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In or Out  

Toggle the EQ on and off with the In / Out radio buttons. You can do this with any red clip 
(touching the cursor on a selected track). You do not have to enter the Edit mode. 

Copying an EQ 

The EQ parameters of a clip can be copied to another clip or Range of clips. 
  

Step 1 Locate the cursor over the source clip. 

Step 2 Click the Copy button on the screen. 

Step 3 The enable checkboxes allow you to choose which of the bands are pasted into your 
target clip(s) 

Step 4 Locate the cursor over the destination clip or define a Range of clips. 

Step 5 Click the Apply button. 

Parameter Display 

Current EQ parameters are always shown at the top of the screen when the EQ menu is 
active, helping to see what is active and what values are current. A graph helps you to see 
what is going on. 

1. There is no limit to the frequency Range for each band, so you can have your low 
frequency higher than your high frequency if you want. 

2. When you are using a Range, it is possible to change one or more bands for the 
entire Range, while leaving other bands as they were. So, for example, the clips 
might have different settings for LOW EQ but the same setting for HIGH EQ. 

Saving EQ Settings 

The system allows you to save the current EQ settings and later retrieve and apply them. 

To save an EQ setting, do the following: 

Step 1 Type a new name into the Presets field (or use an old name if you want to change its 
settings) 

Step 2 Set the EQ values to the ones you want to save, by editing, or simply by “picking up” 
the values by touching an existing clip. 

Click the Save button. 

To retrieve an EQ setting, select it from the Preset drop list. It can then be applied 
immediately to the currently selected clip or range of clips. 

A saved EQ setting can be deleted by first selecting it from the drop list, then clicking the 
Delete button. 

A special preset can be created called “default”. Whenever the Clip EQ display is opened for a 
clip with no EQ, this preset will automatically be loaded into the display. 
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Chapter 11 - EDL Management 

Introduction 

EDL Management supports three activities associated with EDLs (Edit Decision Lists) 
produced by other editing products. 

Capture records the material needed by the edit list, from original sources such as video tape 

Conform edits the source audio recorded in the capture process, placing it at the destination 
locations indicated by the edit list 

Reconform re-edits an existing DREAM II project according to a “cut list”, usually representing a 
re-edit of the pictures in a video project 

Loading an EDL 

The first step is to load an EDL file.  

Step 1 Use the command File  Import  EDL 

Step 2 Navigate to the file location of an EDL file and click the Open button 

This will cause the display of the EDL dialog 
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Capture and Conform 

Capture and Conform are performed at the same time. The audio for each line in the EDL is 
captured and immediately conformed. 

Before starting, we must set some parameters. 

Step 1 Set up Track Mapping 

 

Track mapping chooses the tracks where you will record in your currently open 
project. DREAM II lists each type of edit that it finds in the EDL e.g. A12, A 3 etc., 
and allows you to choose which audio tracks to record for each type. (Often it will be 
the same set of tracks for all edit types.) Click in the Record Trks column for each 
type of edit, and choose from the drop down list.  

The Rec Tracks drop down list provides a convenient way to quickly fill in the track 
mapping for a specific number of tracks per EDL track. 

Presets allow you to save a track mapping for reuse. Type a name into the field and 
click Save. To load a preset, simply select it from the drop down list. 

Step 2 Select Edits to Capture 

The system will capture only the highlighted events in the EDL display. Use the 
mouse to highlight the required events. You can select a range of events by selecting 
the first, then holding down SHIFT and selecting the last in the range. You can add or 
subtract an event from the selection by holding down ctrl and clicking it. 

Events that are marked with an R will not be recorded, even if they are selected.  
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Each time the system performs a recording, the events that successfully record are 
automatically marked this way. You may also click in the checkbox for any event to 
mark or unmark it manually. 

Step 3 Capture Settings 

Handles – you can capture more audio than indicated by the EDL event. This can be 
very useful for adding fades or capturing ambience around the event for use in 
smoothing. 

Preroll – sets the time that the source machine will run up to the recording. Set this 
value to suit the type of source machine being used. Typically tape-based machines 
require at least 3 seconds to lock properly. 

Postroll – sets the time that the source machine will keep running after the recording. 

Step 4 Set up Patching 

Connect the source machine outputs to some of your DREAM II inputs, and use the 
Patch I/O page to patch them through to the recording tracks. The Patch I/O page is 
discussed in detail in Chapter 5 – Patching and Assignment. 

Step 5 Set up Destination tracks for Conform. 

The Destination tracks are those to which the audio will be copied to match the Rec 
Start time for the EDL events. You need only specify the first destination track – the 
software uses the following tracks to place audio for events requiring more tracks. 

Step 6 Click the Capture button 

The EDL Capture and Conform will now go ahead. The software will request the first 
source reel to be loaded on to the source machine.  

 

It will then capture all the audio needed from that reel, optimizing to reduce the 
amount of shuttle time. 

The software will then request the next reel, and continue in this vein until the 
conform is complete. Events that cannot be recorded are marked E (Error). Reasons 
for this can include: 

 Bad timecode causing lost sync before the end of a recording 

 Tape machine not locating to the pre-roll point 

The software will continue after errors of this type, and complete as much of the 
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conform as it can. 

Reconform 

Reconform uses an existing project (or more than one project) as the source audio for a 
Conform. There is no Capture process, as the audio is already present on hard disk, but 
otherwise the process is very similar to Conform. 

Each reel in the EDL may be mapped to a different audio project. 

Step 1 Set up Track Mapping (as for Capture) 

Commonly all tracks will be involved. 

The Record Tracks correspond with the source tracks from the existing Source 
Project. 

Step 2 Select Edits to Reconform (as for Capture) 

Step 3 Link Reels 

Each reel can come from a different project if required. Use the Reel Linking dialog to 
choose the project for each reel: select a reel, then click the Project button and 
browse to the correct Project to be linked. 

 

Multiple reels can be selected at the same time and linked to a single project. 

Step 6 Set up destination tracks 

If all tracks will be involved, choose Track 1 as the destination. 

Step 7 Click the Reconform button 

If one of the linked projects is not found, an error message will be displayed, and the 
reconform will stop. 

If there is no audio between the source In and Out times for an event, an error 
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message will be displayed, but the reconform will continue with the following events. 

Additional Facilities 

Selecting a reel in the Reel Linking dialog also selects all of the EDL events associated with 
that reel. 

Clicking the A button in the Sort group causes the EDL events to be sorted according to the 
EDL event numbers. 

Clicking the C button in the Sort group causes the EDL events to be sorted according to 
source reel. 
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Chapter 12 – Link Groups 

Introduction 

Link groups are designed for controlling groups of Tracks in multichannel formats. Link 
groups simplify many tasks associated with working in surround formats and share many of 
the operational features of surround format buses. Link groups can include up to eight 
members. The simplest link group has two members and fulfils the function of a stereo 
channel. 

Link Group Features 

Linking feeds in link groups has the following effects: 

1. Selecting one member selects the entire link group. 

2. If desired, the members of the link group are panned appropriately in the monitoring 
output. 

Creating a Link Group 

Step 1 Click the Tracks button in the Edit megamode. 

Step 2 Click the Track Format button 

The system displays the Link Group dialog. 

Step 3 Click a track to be the first member of the Link Group (or it can be last member) 

 

The system greys out all tracks except the seven either side of the one chosen. 
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Step 4 Click one of the available tracks to make it the last feed of the group. 

 

Link groups can include a maximum of eight members, which must have contiguous 
number e.g. 3 to 10. 

Step 5 Select one of the options in purple at the right of the screen. 

All Defaults applies pan settings to each member to set the link group into a 
surround format as described below under “Link Group Format”. All 
defaults also applies the mix parameter values of the first member to all 
the members. Parameters modified are fader level, pan, EQ, dynamics, 
aux sends, inserts and direct out state. 

Default Pans applies pan settings to each member to set the link group into a 
surround format as described below under “Link Group Format”. Default 
pans affects the pan parameter only.  

No Defaults no feed parameters are modified. 

Step 6 You may repeat steps 3 to 5 to make more Link Groups. To close the dialog, click the 
Close Box, or right click anywhere in the dialog, or press the Esc key on your 
QWERTY. 
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You can collapse the linked tracks down to the width of one track by double-clicking 
any of the linked tracks, close to its left side. Do the same thing to expand them. 

Link Group Format 

When a link group is created with default pans selected, the number of members determines 
the format of the link group. When a link group is created, you have the option of retaining 
the current pan setting of each member or using default pan settings for the chosen format.  

If default pans are selected each member of the group is panned to one element of the bus 
in the following order: 

If 2 Feeds are linked, they are panned L R. 

If 3 Feeds are linked they are panned L C R. 

If 4 Feeds are linked they are panned L C R S. 

If 5 Feeds are linked they are panned L C R LS RS. 

If 6 Feeds are linked they are panned L C R LS RS B. 

If 7 Feeds are linked they are panned L C R LS CS RS B. 

If 8 Feeds are linked they are panned L LC C RC R LS RS B 

Normally each member is panned hard to one Bus Element position, spread is set to 
maximum, divergence is set to minimum and rotation is set to zero.  

If you are using a link group to control a premixed stem which is delivered in a different 
channel order, it may be necessary to edit the track order on the disk recorder or to change 
the input patching of the feeds if the stem is played in off an external device. 

Destroying a Link Group 

Link groups are destroyed from the Link Group Dialog. 

Double-click 
here to collapse 
or expand the 
linked tracks. 
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Step 1 Click the Tracks button in the Edit megamode. 

Step 2 Click the Track Format button 

The system displays the Link Group dialog. 

Step 3 Click a Track in a Link Group to select the Group. 

Step 4 Select Unlink or Unlink and Reassign from the commands at the right.  

Unlink  unlinks the members without reassignment 

Unlink and reassign  unlinks the members. If the Link Group had a Boom member 
that was de-assigned from all other Bus Elements, it is reassigned to them. 

To close the dialog, click the Close Box, or right click anywhere in the dialog, or press 
the Esc key on your QWERTY. 
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Chapter 13 - Name 

Introduction 

Pyxis G2 allows you to rename tracks and clips, and to setup ‘seed names’ for recording. 
When a name function is selected, the original name appears in a popup window. You can 
then use the BACKSPACE key to delete the original name and supply a new one. 

Naming Tracks 

Step 1 Select the Track(s) you want to rename 

Step 2 Use the command Tracks  Rename Track. 

Step 3 Type the name in the popup window that appears on the PC screen. 

Step 4 Press Enter on the QWERTY keyboard, or click OK. 

There is a maximum of 16 characters allowed for naming tracks.  

Note that all the selected tracks will be given the same name at the same time! 

Naming Clips 

To rename a clip, use the command Edit  Rename, then type the new name for the clip 
and press Enter on the QWERTY keyboard or click OK.  

Seed Names 

Names are given to all new recordings in a Project. You will notice that recordings are given 
an incrementing number for each new clip. Seed names allow you to enter a name prefix that 
will be given to each new recording, to which an incrementing number will be appended. 

Each track has its own Seed Name, but you may apply the same one to many tracks. 

To set the seed name for one or more tracks: 

Step 1 Select the Track(s) you want to rename 

Step 2 Use the command Tracks  Set Record Seed Name. 

Step 3 The system displays a dialog box. 
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Step 4 Enter the Seed Name you wish to use on the selected track(s). 

Step 5 Enter the Seed Index 

This is the number that will be used on the next recording made on any of the 
selected tracks. You may set this to any value you like, even if it has already been 
used. 

Notes: 

1. The system defaults to the Seed Name “Recorded Audio” on all tracks. This results in 
lots of clips called Recorded Audio N. 

3. Use only the following characters in names: A - Z, a - z, 0 - 9, _ (underscore) 

4. When multiple tracks with the same Seed Name are recorded, the results depend on 
whether the seednames were applied at the same time, or separately. If they were 
applied separately, the resulting clips follow an independent sequence of numbers on 
each track. This means you can get exactly the same name on different tracks.  

5. If the names were applied together, the resulting clips have a range of numbers, 
increasing by one with each increasing track number. So for example, if: 

 The Seed Name is Clip 

 The next number is 5 

 Tracks 1, 2 and 12 are in record 

6. Track 1 will get Clip 5 

7. Track 2 will get Clip 6 

8. Track 12 will get Clip 7 

9.  
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Chapter 14 - Solo and Mute 

 

Click the M and S buttons to mute or solo any track. 

Double click the M or S button to make it the only muted or soloed track. 

Selected Tracks 

You can solo all the current selected tracks using the command Tracks  Solo Tracks 

You can mute all the current selected tracks using the command Tracks  Mute Tracks 



Operator Reference Manual  CHAPTER 15 - GO TO September 15, 2011 
 

Pyxis G2 Page 104 

Chapter 15 - Go To 

Introduction 

The Go To Menu is used to locate to timecode locations or named clips. After the transport 
has located to the target, you will be returned to the mode you were in before the GO TO 
command. 

Go To a Timecode location 

Step 1 Click the Timecode field at the top of the screen. 

 

Step 2 The system displays the current timecode. If desired, type over the timecode using 
the numeric keypad or the QWERTY keyboard. 

  

Step 3 Press Enter or click OK to move to the new timecode location. 

Editing Timecode Numbers 

The following shortcuts can help to speed up Go To operations. 

1. The left and right arrows on the QWERTY keyboard can be used to move from field 
to field in the timecode number. You can then start typing the timecode number from 
that field. 

10.  
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2. The up and down arrows on the QWERTY keyboard can be used to increase or 
decrease the current timecode field by one. 

Go To Clip Name 

The Go to Clip function locates the transport to the head of the desired clip. It also 
incorporates an alphanumeric search function to help sort through clips by name. 

Step 1 Use the command View  Clip Search 

Step 2 The Clip Search dialog is displayed. 

You can shorten the list by typing a sequence of characters in the text field at the 
lower left. Only clip names containing that sequence will be shown, so as you type 
more characters, the list will get shorter and shorter. 

Step 3 Select the desired clip using the mouse. 

Step 4 Press Enter to locate to the selected clip. 

The Clip Search Dialog 

 

While the Clip Search dialog is open you can: 

 Filter the list by typing a sequence of characters in the text box. Only clip names 
containing that sequence will be displayed. 

 Sort the clips in track order, start order, end order or duration or clip colour, by 
clicking on the column header. Clicking the header a second time reverses the sort 
order. 

 Double click any clip to locate to its timecode. 
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 Select the Under Playhead checkbox, to display only clips touching the cursor. This 
is updated as the transport moves. 

 the Pop button, to bring the currently selected clip to the top layer on its track. This 
can be used to manage multiple takes of the same recording, layered on a single 
track. 

 Select the Only Offline Clips checkbox, to reduce the list to only those clips for 
which media are not currently available. 

 Click the Reveal File button to display a Windows Explorer window, showing the 
file containing the media for the clip. 

 Resize the dialog by dragging with the mouse on any of its sides. 

 Change the order of displayed fields by dragging the field names horizontally with the 
mouse. 

The Clip Search dialog can be displayed at any time using the Edit Screen menus:  

View  Clip Search 

This allows you to keep it on the screen while you do other types of editing. 

Go To Mark 

The Go to Mark function locates the transport to any stored Mark that you have created. 

Step 1 Use the command View  Marks 

Step 2 The Marks dialog is displayed. 

Step 3 Use the mouse to click on the desired mark. 

Step 4 Click Jump to locate to a mark, or double-click the mark. 

While viewing the list of marks, you can also select and edit them, changing their names and 
timecode locations. 

While marks are displayed, you can double-click on any item to locate to its timecode. 
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Chapter 16 - ADR 

Introduction 

Pyxis G2 provides the ability to automate recording using a list of In and Out points with a 
simple interface. The ADR menu includes functions for setting pre and post-roll and features 
for automatic dialogue replacement. 

The ADR List 

The ADR List allows you to set up a list of recordings – cues –  that you want to take. Each 
one has a controlled In and Out point, and text that can be displayed on the screen. 

To open the ADR List, click the ADR button in the Tools menu. 

 

When it is first opened, the list is empty of cues. 

Adding a Cue 

Step 0 Optionally, create a range covering the cue you want to add. This is probably the 
quickest way to set the In and Out times for your cue. (If there is no range, the cue 
will be created with the transport position as its In time, and 5 seconds duration.) 

Step 1 Click Add Cue. 

 A dialog appears for writing the text of your cue. 
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Step 2 Enter the text and click OK. 

Step 3 If necessary set the In Point of the cue: locate the transport to that point and click 
From. Your current position will be shown in a dialog. You may accept this by clicking 
OK. 

OR 

Click From, type the timecode you want, and click OK. 

Step 4 If necessary set the Out Point of the ADR cue in the same way. The cue is shown as 
below. 

 

ADR Characters 

Your project may contain a list of characters, and the cues assigned to different ones. 

Creating characters 

Step 1 Click in the Character box (which normally shows <Show all>) 
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Step 2 Type the name of a new character 

Step 3 Click the Add button 

Filter by character 

To show only one character’s lines, use the Character drop down menu to select one 
character. 

 

Sort by character 

To sort the list by character, click the Character tab at the top of the ADR list box. 

 

In the same way you can sort by From time, To time or dialog alphabetically. Click any one of these a 
second time to reverse sort. 

ADR Preferences 

Once you have entered all the cues that you want to use, you may set up your preferences 
by clicking the ADR Menu and selecting ADR Preferences. The following screen is displayed. 
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The main purpose of this dialog is to control beeps and the streamer. The streamer is a pair 
of vertical lines moving across the Pyxis screen during the Preroll to the cue. At the same 
time as the audible beeps, the line extends upwards and downwards briefly. The two lines 
come together at the cue point, and a large cross is shown. The extensions and cross can be 
given a different colour to the lines. 

Note: the number of beeps (and corresponding streamer crosses) is controlled in this dialog, 
but the Preroll must be long enough to accommodate them. If the Preroll is too short, some 
of the beeps will be omitted. See below for instructions on setting the Preroll. 

The text referred to is that shown on the Decklink output from the Pyxis Track. The font, 
colour, height control and Wrap Text control are used to customise the text display. Note: 
this text display is not shown on the Edit Screen Pyxis Window, only on the independent 
monitor fed by your Decklink card (if fitted). Use the ADR Display, described below, to show 
text over the Edit Screen. 

The ADR Display 

 

The ADR Display is a band across the screen which displays the ADR text, and also gives an 
indication of the start point for the cue. An example of the streamer is shown below. 

The text is shown, and the indicators converge on the centre of the screen, arriving at 
precisely the In time of the cue. 

To turn it on, use the toggle ADR  ADR Display. 
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Cycle 

The Cycle command is used to initiate ADR actions. It will execute rehearsal, recording and 
playback, depending on the mode of the ADR system. See below for details. 

Preroll and Postroll 

It’s usually necessary to set a preroll for recording. This allows the recording artist to get 
ready for the start. 

Postroll is useful for hearing how the new recording fits into the track. 

Set preroll and postroll using the appropriate fields in the ADR List. 

Once you have entered all the cues that you want to use, you may set up your preferences 
using the command ADR  ADR Preferences. The following screen is displayed. 

 

The main purpose of this dialog is to control beeps and the streamer. The streamer is a band 
across the screen which displays the ADR text, and also gives an indication of the start point 
for the cue. An example of the streamer is shown below. 

 

The text is shown, and the indicators converge on the centre of the screen, arriving at 
precisely the In time of the cue. 

To turn on the Streamer, click the ADR Menu above the Track display, and select ADR 
Display. 
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Cycle 

The Cycle command is used to initiate ADR actions. It will execute rehearsal, recording and 
playback, depending on the mode of the ADR system. See below for details. 

Rehearsing a cue 

You may rehearse cues before recording them. Is this needed in a system where all recording 
is non-destructive? Your call. 

Step 1 Click the Rehearse button. This puts the ADR system in Rehearse mode.  

Step 2 Select a cue. The transport will locate to its In Time. 

Step 3 Click Cycle. This will cause the transport to drive through the In and Out points 
once, switching the track from repro to input, simulating the record experience. 

Click the Stop button at any time to stop the take (or use the Stop button in the transport 
controls). 

Note: When the ADR is in Rehearse mode, double-clicking a cue will select it and initiate a 
rehearsal Cycle. 

Recording a cue 

Step 1 Click the Rec/Playback.  

Step 2 Select a cue. The transport will locate to its In Time. 

Step 3 Click Cycle. This will cause the transport to drive through the In and Out points, 
recording a take, then cycle through again for playback. 

Click the Stop button at any time to stop the take (or use the Stop button in the transport 
controls). 

Note: When the ADR is in Record mode, double-clicking a cue will select it and initiate a 
recording Cycle. 

Playing Back a cue 

Step 1 Turn off the Rec/Playback button. This puts the ADR system in Playback mode.  

Step 2 Select a cue. The transport will locate to its In Time. 

Step 3 Click Cycle. This will cause the transport to drive through the In and Out points 
once, playing back the audio. 

Note: When the ADR is in Playback mode, double-clicking a cue will select it and initiate a 
playback Cycle. 

Pre-Record 

Pre-Record allows you to enter record a little earlier than the time of the cue. This is useful 
when recording artists that tend to anticipate the entrance. The streamer will still indicate the 
cue in time, but you are able to capture the audio a little earlier. 

Early In 

Early In can be clicked during the preroll of a record cycle. It causes recording to start 
immediately. 
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Rec Out 

If desired, the system can ignore the Out time of the cue, and just keep recording until you 
exit manually (using Stop, Jog, Rewind etc). 

The Rec Out screen button controls this. When unselected (grey) the record Out time will be 
obeyed. When selected (yellow) manual exit will be used. 

Keep Playing 

At the end of a cycle you may wish to keep playing, in order to hear the next section of track. 

Clicking the Keep Playing button at any time during a cycle will cause the postroll to be 
ignored, and the system will enter normal Play mode after the cue’s Out time. 

Importing ADR cue lists from a text file 

You may import an entire script through the use of the Import button. This can import a 
short script that has been written in a word processor. 

Each line of text in the file is treated as a separate line of ADR cue text. 

Each line of text can optionally have one or more timecode numbers at the start of the line: 

00:00:00:00 This line has one timecode number 

or 

00:00:00:00 00:00:01:12This line has two timecode numbers 

The first timecode number becomes the cue-in point and the second, if present, the cue out 
point. Timecodes must contain 4 individual numbers separated by colons: 01:00:23:12 or 
semicolons if the timecode is drop-frame based: 01;01;00;02 

Here is an example of a text file in the correct syntax with timecode numbers at the start of 
each line: 

00:02:19.19 Her eyes shined bright and true 

00:04:57.07 00:09:42.18 Do not look now, but.... 

23:58:39.03 00:02:58.19 Haven't I seen you before. 

The format described above is the native format used by Pyxis NLV for storing ADR cue lists. 
You can edit the stored ADR cue lists directly in any word processor or text editor, as long as 
you make sure you save the file as a text file. 

Beeps 

Audible beeps count down to the record in point. The beeps are heard on the lowest 
numbered armed track, but only if it is audible. For example, setting the monitoring of the 
track to INPUT will prevent the beeps from being heard. Normally monitoring should be set to 
AUTO. This is done as follows: 

Pres  
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Chapter 17 - Marks 

Video Locators 

Video Locators are created by dragging video frames to the Locator thumbnails in the Dream 
II Pyxis track: 

 

Video locators are also indicated by yellow pointers on the timescale. 

Creating a Video Locator 

To create a Video Locator, click on a currently vacant locator icon. The current video frame is 
thumbnailed and displayed in the icon. 

Editing Marks 

To edit marks, select View  Marks from the onscreen menu. 

Video Locators 
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Click the appropriate button to set the Mark time, rename the Mark or remove it. 

Double clicking a Mark also jumps the transport to its timecode. 
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Chapter 18 - Import / Export 

Introduction 

Pyxis G2 has a number of features to allow the import and export of audio clips and Projects. 

Importing Files 

DREAM II can import the following file types: 

Video Files – these can be displayed on the Pyxis track 

Pyxis Projects – these are projects created using the program “Pyxis” 

OMF Files – these are files from other manufacturers 

ML Files – these are files from older Fairlight products. 

AES-31 Files – these are files from from other manufacturers 

AAF Files – these are files from other manufacturers 

MXF Files – these are files from other manufacturers 

Importing Video Files 

See Chapter 5 – Video Track. 

Importing an OMF 

Step 1 Use the command File  Import  OMF Project 

Step 2 Browse to the location of the omf and select it. Press OK 

Step 3 The following dialog box is displayed 

 

Import Media 

“Preview Media” references the audio files from the omf – this may cause slowdowns on large 
projects 

Note If the project is an *.MT project, stuffing the fufs will render all audio to the current 
project 

If the project is a *.DR2 project, using the “Localise” command will place all the audio in a 
folder inside the project folder. 
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“Fully Import Media” automatically places the audio from the omf in either your FUF or folder 
inside the folder of the current project 

Clip Naming 

“Standard” derives the names of clips from the omf “Master Clip” within the omf file. 

“Sub-Composition” - OMF’s created in AVID often derive clips from either the “Master clip” 
and the “Sub Composition”. This option derives the names of clips from the “Sub-
Composition”. Use this setting to give your clips more logical names if they are coming from 
an AVID and not displaying logical clip names. 

Offset 

Entering a timecode offset moves the whole composition forwards on the timeline. 

Entering a track offset moves the whole composition down in the track display. 

Importing Individual Sound Files 

Sound files of various types can be imported  directly into your Dream II project. These 
include the following: MP2, MP3, WAV, BWAV, AAC and more. 

To import one use Windows Explorer (or My Computer) to locate the file, then drag and drop 
it on to the Dream II Edit Screen. The file will be placed at the cursor position (or in the 
range), on the track where you drag it (unless you use the options below). 

Found at Setup  General Preferences  Options: 

 

Place Files at Embedded Timecode 

Some audio files carry a timecode with them. Checking this option for a particular file 
type causes it to be placed at that timecode, no matter where you drag it with the 
mouse. 

Place Files on Embedded Track 

Some audio files carry a track number with them. Checking this option for a particular 
file type causes it to be placed on that track, no matter where you drag it with the 
mouse. 

Sample Rate Conversion 

Sometimes the files you import are at a different sample rate than the project. When this 
happens, Dream II automatically turns on real-time sample rate conversion to ensure the 
audio has the same pitch and duration as the original. 

Clips subject to sample rate conversion are marked with a black SR label. 

The quality of sample rate conversion may be varied using the dialog Setup  General 
Preferences  General: 
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Fast Puts a small load on the computer system, but doesn’t sound so good. Very useful 
when there are a lot of clips to be sample rate converted, or a lot of plug-ins in the 
project. 

High Quality 
Sounds good but loads down the CPU 

If you need good quality and have lots of clips to sample rate convert, you can localise the 
media, which performs the best quality sample rate conversion and re-references the clip. 

Step 1  Select the clips that need to be sample rate converted 

Step 2 Issue the command Process  Localise Audio 

Use handles if the clip has been edited, and might need to be re-extended 

Select all clips using this media before localising, and the system will only produce a 
single piece of media which they can all reference. 

Export 

Exporting Audio 

You can export audio from a Project in the following formats: 

 WAV  

 Broadcast WAV 

 Aif 

 AES-31 – This consolidates your project into a file used by other manufacturers 

Step 1 Select the clip or clips to be exported. Ranges of clips can also be selected. 

Step 2 Use the command File  Export  Audio Tracks/Clips 

Step 3 The following dialog box appears. 

 

 

Make your selections and click OK. 
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File Type 

Select Wav, BWave or AIF files. BWave files will be exported with the timecode stamp from 
the Dream II timeline. 

Export Using 

Select Clip EQ and/or Clip Level to render Clip EQ and/or Clip Level into the exported file(s). 

Normalize 

Normalize will examine the level in every clip you have selected, find the maximum level of all 
the clips, then show the gain increase needed to bring it up to 0 dB. Then all the clips will be 
amplified by this amount, giving you the loudest (best quality) signal possible while 
maintaining correct balance 

Audio Type 

Select bit depth and Sample Rate for exported file(s). Defaults to Project sample rate and bit 
depth. 

Mixdown 

Select ‘Entire Project’ to export the entire project (one file per track in Multiple Mono Mode). 
Select ‘Between Range’ to export all audio in the current range (one file per track in Multiple 
Mono Mode). Select ‘Selected Clips’ to only export selected (red) clips (always one file per 
clip, regardless of selected Channels). 

Check ‘Selected Tracks Only’ to only export selected tracks. Check ‘Align to Video Frame 
Boundaries’ to align exported file(s) with the video frame edges. Check ‘Export Empty Tracks’ 
to export blank files for empty tracks (if Multiple Mono files have been selected). 

Then select the location you want the exported audio to go and hit “OK” 

Channels 

Allows you to select the format of the files being created by export. 

 

Mono files, 1 per track 

Creates a single mono media file for each track in the export i.e. all tracks or selected 
tracks, depending whether the Selected Tracks Only checkbox is selected 
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Stereo files, 1 per track pair 

For each pair of tracks in the export, a single stereo media file is created 

Mono/Stereo files (automatically choose) 

If a track is mono, and contains no multi-channel clips, its contents will be exported 
as a stereo media file. 

If a pair of tracks are linked as a Link Group, their contents will be exported as a 
stereo media file.  

If a track contains a two-channel clip, its contents will be exported as a stereo media 
file. 

Mix Track to a single Mono File 

All tracks in the export are mixed together to form a mono mix, and this is recorded 
into a mono media file. 

Mix Track to a single Stereo File 

All tracks in the export are mixed together to form a stereo mix, and this is recorded 
into a stereo media file. 

Single MultiChannel File (all selected tracks) 

A single file is created with multiple linked media, one for each track in the export. 

Exporting Video 

You can export the video straight from a project and automatically combine it with your 
choice of audio from a project. 

Step 1 Use the command File  Export  Video 

This box pops up 
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Step 2 Choose the video format you wish to export as 

Step 3 Choose whether you want to export the whole project or a selected range 

NOTE to export as a Quicktime file you must have the latest version of Quicktime installed 
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Chapter 19 - Monitoring 

Introduction 

Pyxis G2 provides three monitoring buses in the most popular formats, 5.1, Stereo and Mono. 
It allows any number of tracks to be assigned to the monitor buses. 

Assigning Tracks to Monitor Buses 

Step 1 Click the Monitor Assign button in the Setup megamode 

Step 2 The Buss Assign Panel is displayed. Click to select the destination bus to which you 
want to assign signal paths. This can be the 5.1, Stereo or Mono bus. 

The selected bus key will be highlighted. The keys of Tracks already assigned to that 
bus will light up. 
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In this case we have selected the 5.1 Monitor bus. The tracks assigned to it are 
highlighted. 

Step 3 Click any Track tile to toggle its assignment on or off. 

Press the All Tracks soft key to assign all tracks to the selected bus. 

Press the deassign all soft key to deassign all sources. 

Step 4 Press the Bus Assign key to return to the previous mode or select any other mode. 

Monitor Control 

You can choose between the three monitor buses for listening in Pyxis G2. 

To choose amongst these sources: 

Step 1 Click the Monitor Control button in the Setup megamode. 

 

While the Monitor Control dialog is open you may: 

 Choose one of the three sources at the left. 

 Click the Mute button to toggle the monitoring on and off. (The monitor system is 
always muted immediately after a project is loaded). 

 Choose between your Main and Alt speaker sets 

 Control the volume by clicking on the rotary knob and dragging the mouse in a circle 
around it. 

Monitor Speaker Sets 

Pyxis G2 supports two sets of speakers, called MAIN and ALT. Each of these can be set up 
with its own surround format and physical outputs from the system to its amplifiers. One set 
of monitors can be switched on at a time. 

Where the current source surround format is different from the current speaker set surround 
format, the Monitor Matrix provides the necessary fold-up and fold-down. 

To choose a speaker set: 
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Step 1 Click the Monitor Control button in the Setup megamode. 

Step 2 Click on Main or Alt to choose that speaker set. 

Setting Up Speaker Sets 

To set the format and select the physical outputs for the Main and Alt monitor sets follow the 
steps below. 

Step 1 Click the Monitor Setup button in the Setup megamode. 

The system displays the Monitor Setup dialog 

 

Step 2 Click one of the Speaker Sets, MAIN or ALT. 

Step 4 To determine the number of outputs required, you must specify the format of the 
speaker set. Click the Increase Format button to cycle through the available 
formats. These are Mono, Stereo, LCR, LCRS, LCRSS, 5.1. 

Step 5 Select the type of physical output you wish to patch to by clicking Analog Outputs 
or Digital Outputs. 

Step 6 Select one or more speakers in the upper left. 

Step 7 To patch outputs to the selected speakers, select the same number of outputs, and 
click the Patch button. 

Step 8 To name the selected speaker set, click the Rename button, type a name and press 
the Enter key. 
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System Outputs 

Specific outputs may be defined for use with control room monitors only. System output ports 
are only available for patching in the Monitor Setup Patching page. System ports are defined 
in the I/O Config.TXT file as described in “The I-O Config.TXT File” on page 229. Use system 
output ports for patching your control room monitors to avoid accidentally patching other 
sources direct to the power amplifier inputs. 

Specific outputs may be defined for use with control room monitors only. System output ports 
are only available for patching in the Monitor Setup Patching page. System ports are defined 
in the I/O Config.TXT file as described in “The I-O Config.TXT File” on page 156. Use system 
output ports for patching your control room monitors to avoid accidentally patching other 
sources direct to the power amplifier inputs. 
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Chapter 20 – Project and File Management 

Introduction 

File handling in Pyxis G2 supports legacy formats from previous Dream II products, but also 
introduces powerful new Project and File management capabilities. This chapter details the 
way the system looks after files. 

Project Formats 

In Pyxis, two “native” project formats are supported. 

The newer format has the extension DR2. It has the strongest feature set, and is always used 
for newly created projects. 

The older format is called MT. This was introduced in the DREAM I product series, also known 
as QDC systems, and is maintained with full backward compatibility by DREAM II. This means 
you can open MT files, add new material to them, edit them, and resave. You can also save 
DR2 files in the MT format, for use on older machines, using the Save As command. 

Choosing Format 

At the time of creating a project file, the system offers the choice of project formats in the 
New Project dialog: 

 

There is no way to change project format after creation, but you can save a copy of the 
current project in the “other” format using the File  Save As command. 
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If you save a project into the MT format, it will load and play on QDC systems. 

MT Projects 

The MT Project format is designed for backward compatibility with Fairlight QDC systems 
running software version 19.2.11 or higher. Dream II can also open MT files created on older 
Fairlight systems, dating back to MFX3+ systems running rev 15.x software. 

If you are planning to swap projects with QDC systems, use the Save As command to 
produce a copy of your project in MT format. 

Recording Files (FUFs) 

When using the MT project format on a Dream II system, new audio recordings are stored in 
‘FUF’ files. ‘FUF’ stands for ‘Fairlight Universal Format’, and a FUF file acts as an ‘audio 
container’ with many individual audio files bundled inside it. 

FUFs are saved as soon as the recording is complete. At this point the audio media is written 
to disk, but it is still not “safe”. The clip(s) that appear in the edit screen immediately after 
recording are the ONLY reference to the recorded material. They are stored in the Project 
(MT) file, and until that file is saved, the audio is not secure. 

FUFs can only grow to a maximum 4GB to maintain QDC compatibility, and new FUF files are 
generated automatically as required.  

FUFs are automatically named based on their parent project. So, a project named 
MyProject.MT might have FUF files named MyProject_001.FUF, MyProject_002.FUF, 
MyProject_003.FUF and so on. FUF files are automatically created in the same subfolder as 
the MT project. You must not delete FUF files unless you wish to remove audio from your 
project! 
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When copying MT projects to a compliant QDC engine, you must always be sure to copy all 
associated FUF files. Otherwise, the QDC will not be able to find all of the audio data used in 
the MT project. 

 

The picture above shows the typical file layout with an MT file. The FUF file contains the 
audio, while the MT file contains the Edit list, mix information, and automation files. Note: 
The FUF file will generally get much larger, up to 4 GB, while the MT file already contains a 
full complement of mix data (even if mostly zero values), and will only get bigger when 
automation files are saved. 

When the first FUF file reaches 4 GB, another one is automatically created. 

Stuffing FUFs 

Dream II allows external files to be dragged and dropped onto the timeline. Since these files 
are not recorded into the Dream II MT Project, they are not automatically added to the FUF 
files associated with the MT Project. If you want to transfer the MT project and all external 
audio files to QDC or to another Dream II system, select ‘Stuff Fufs – All Clips’ or ‘Stuff Fufs – 
Selected Clips’ from the Dream II ‘Process’ menu. This will copy all external media into the 
Project’s Fuf files. Please note that this process can take some time, depending on the 
quantity and size of external files that need to be stuffed. “Stuffing Fufs’ is a background 
task, so you can keep working while Dream II is processing. However, you cannot save your 
project until Fuf Stuffing is complete. 

When dragging and dropping files onto the Dream II timeline, you may notice some files are 
‘Fuf Stuffed’ automatically. Dream II performs Fuf Stuffing automatically when it is required 
for QDC compatibility (for example, if you drag a file larger than 4 GB onto the timeline).  

Dream II users can also copy clips from one MT project to another. In doing so, the user 
creates a relationship between Fuf files belonging to one project and Fuf files belonging to 
another. Using ‘Save As’ with an MT file has the same effect, and creates a ‘Parent/Child’ 
relationship between the original MT Project and the saved version. To break any such inter-
Project dependencies, select  
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Process  Detach  

from the Dream II menus. After detaching your MT Project, you can select  

Process  Stuff Fufs – All Clips or  

Process  Stuff Fufs – Selected Clips to consolidate all audio into Fufs associated with your 
current project. 

If you are unsure of what file a clip is stored in, you can find out by selecting View  Clip 
Search from the Dream II menus. You will see the filename associated with each clip in the 
list, and you can click the ‘Reveal File’ button to display a file in Windows Explorer. Note that 
you can rearrange columns in the clip search window by dragging and dropping column 
headers. You may need to scroll to the right to view all available clip search columns. 

Always take great care not to delete files associated with your MT Project. You may not be 
able to recover files once they have been deleted! 

DR2 Projects 

DR2 (Dream II) projects are a new project format designed specifically for Dream II. DR2 
files are not backwardly compatible with older Fairlight products, although they can be 
converted to MT projects with FUF files as described above. The DR2 file format provides 
enhanced capabilities compared with the legacy MT file format, and all future development 
will focus on the DR2 file format. 

Recording in DR2 

When using the DR2 format, new audio recordings are stored as industry standard Broadcast 
WAV Files. Dream II Broadcast WAV Files are stored in the ‘Media’ subfolder of the DR2 
Project folder. 

The WAV files are created when recording starts, and they are refreshed at regular time 
intervals during recording. When this happens, all but the last part of the recording is safely 
on disk. This means that audio recordings in DR2 format are quite secure – even if the 
project file is lost (or never saved) the WAV files are viable stand-alone containers for audio 
media. References to them can easily be imported and re-synchronised in a new project, or in 
any other project. This process is described below as “Recovering Lost WAVs”. 

 

The picture above shows the typical file layout with a DR2 file. The Media folder, which is 
automatically created by the system, contains the audio in the form of WAV files, while the 
DR2 file contains the Edit list, mix information, and automation files. 
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The Media folder looks like this. The WAV files are named as follows: 

Clip Name _ Track number _ GUID.wav 

The Clip name is the automatic name given to the clip by the system (see Seed Names on 
page 101). Or you may have named the clip while recording it (see Naming Clips on page 
101.)  

The Track number is the one on which the audio was first recorded. 

The GUID is a system number, discussed below. 

GUIDs 

Dream II Broadcast WAV Files are named using ‘GUIDs’. A GUID is a unique ID that makes it 
easy for the system to locate files in a database. Since GUIDs are hard to read, Fairlight has 
created the Fairlight Shell Extension for Windows Explorer. The Fairlight Shell extension is 
installed by default, and allows users to view hidden iXML metadata in the Fairlight Broadcast 
WAV Files. The Project Name, Clip Name and Frame Rate are embedded in each WAV file by 
Dream II during recording, and can be viewed with the Fairlight Shell Extension. 

Using the Fairlight Windows Explorer Shell Extension: 

1. Open Windows Explorer. 

2. Under the 'View' menu, select 'Details'. 

3. Right click a column header (eg - 'Name') and select 'More' from the popup. 

4. Scroll down to the bottom of the list and add the desired iXML columns (eg - 
'Project') you wish to view. 

5. Click 'Ok'. 

Localize 

Localizing audio means putting the files in the same folder as the Project file. Any audio 
which is referenced out of other folders is copied into the Media folder for the current Project 
file, as new WAV files. Once a project is localized, it is much easier to move it to another 
system, or back it up, because all the media is in one place. 
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To localize files in a DR2 project, select the Localize command from the Process Menu above 
the Editing screen. The displayed dialog will ask whether you want to localize all files, or just 
the selected ones. 

 

Handles 

Localizing only copies those sections of the original recordings that have been actually used in 
the project. Anything that has been edited out will not be present. To provide insurance for 
future editing you can save “Handles” on each piece of audio. These are extra pieces of audio 
that can be exposed using the Trim menu. It’s advisable to use handles unless the edit is 
absolutely final. 

Recovering Lost WAVs 

If a DR2 project has not been saved recently, any recordings made since the last save will not 
appear in the project next time it is opened. These recordings can be recovered and 
resynced, as follows: 

Step 1 Open the DR2 Project 

Step 2 Open the folder in Windows Explorer that contains this project. Open its Media folder. 

Step 3 Identify the WAVs that are missing from the project. These will normally be the most 
recent ones i.e. the ones with the latest modification date. 

Step 4 Drag the missing WAV files from their folder to the DREAM II track display, and drop 
them there. 

Step 5 For each WAV file that you have dropped, select it and notice the track number 
embedded in its name. Place it on that track. 

Step 6 For each WAV file select it by moving the transport until it is underneath the play 
head, then issue the command Edit  Resync to Record Time. This will place the clip 
at the time where it was originally recorded. 

Waveform Profiles 

Dream II stores waveform profiles for all the media in your projects, allowing it to display full 
screen waveforms at any zoom range. 

The waveform profiles are extracted and stored in the background after any recording or 
import function, or whenever a piece of media does not have a profile. 

After some time the number of profiles can get quite large and use a lot of space on your 
computer. The system automatically deletes profiles if they have not been used for a certain 
number of days. To control how many days, use the command Setup  General 
Preferences  Projects 
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The default is set at 90 days, but you may change that to any time you like. 

Revealing the Project File 

To display a Windows Explorer Window containing the currently loaded project, use the 
command File  Reveal Project File 

Backup Files 

Each time a DR2 file is saved, an optional backup of the previous saved version can be made. 
This will only happen if your system is set up correctly. 

To enable backup saving, issue the command Setup  General Preferences, and go to the 
Projects tab. 

 

Set the number of backups you would like to keep. The system default is 5, which means the 
5 most-recent saved versions of your file will be retained. 

Automatic File Saving 

Automatic File Saving allows you to save your project automatically at regular time intervals. 
To set this up, issue the command Setup  General Preferences, and go to the Projects tab. 
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Set the desired interval for Auto Save, or turn it off. 

Note: When the time for an Auto Save arrives, it will wait until the transport is stationary, 
then take control of the system. While saving, it will prevent the transport from starting, and 
mute all audio at the outputs. This is necessary to prevent unwanted interaction with the 
automation system. 

Undo Files 

Pyxis G2 allows unlimited UNDOs for audio editing. It does this by storing a copy of the Edit 
list each time an edit is made. 

The undo files are stored in the folder C:\Program Files\Fairlight\Dream II\Undo 

Each time a project is opened, the system starts writing undo files for it, starting with a file 
called UndoFile_00.1.  This file name does not contain the project for which it was created, 
because the system is designed only to work with the currently open project file. 
(Immediately after reopening any file the UNDO command cannot be issued – it only works 
on edits made in the current sessions.) If there is an UndoFile_00.1 already in the folder 
(which there almost certainly is) it will be replaced with this one. 

This means that undo files from older projects are difficult to identify. But if you have wrongly 
(and very recently) saved a project, and you wish to access a previous version of the edit list, 
take the following steps: 

Step 1 Open the folder C:\Program Files\Fairlight\Dream II\Undo 

 

Step 2 Choose the undo file you want to open. Rename this file so that it has an extension 
“dr2” (upper or lower case – it doesn’t matter). 

Step 3 Move this file to a Media Device. The simplest is to move it to the folder on your 
audio drive where the original project is stored. 

Only these two 
files are from 
the most recent 
project. 
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Step 4 Open this file by issuing the File  Open command or using the Project Menu open 
soft key. 

Video Files 

Pyxis G2 supports drag and drop import of a variety of video file formats, as well as direct 
video recording to the Pyxis G2 timeline. 

For correct operation, video files must be played from and recorded to a separate hard disk 
than the audio data. **WARNING: If you attempt to play video and audio data from the same 
hard disk, you will experience SEVERE performance problems!! 

The disk bandwidth required for video is governed by the type of video you wish to play back. 
Some types of compressed Standard Definition video may play back from a single 10,000 
RPM SATA drive, while uncompressed High Definition Video may require a large, fast RAID 
array. Please contact your Fairlight distributor to discuss your specific needs. 

Typical Pyxis G2 Drive Configuration 

 

Designating Media Device 

When Pyxis G2 is first started it displays a dialogue box requesting that a default project 
device be selected. Select the devices (Audio and Video) you wish to use from the list of 
available drives. 

To prepare the drive for use with Pyxis G2, select Setup  Media and Project Management  
from the Pyxis G2 main menu. Select the device from the devices list and click on Convert to 
Media device. Please also set the Device Info accordingly (in most cases, this is set 
automatically and does not need to be changed). 
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To use a network connected device, first create a mapped network drive or folder in Windows 
Explorer. This can now be selected in the device panel and converted to a DREAM II Media 
Device as above. 

** Please note that audio and video files can only be played from a designated Media Device. 
If you try to play files from any other disk, you will receive an error message. 

Controlling Scanned Folders 

You may wish to save time when the system starts by omitting the scan of some folders in 
your system. This is particularly useful when the system is connected to a network. Clicking 
the downward facing “V” shown above expands the display to show folders, as seen below. 

Click here for 
folder display 
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While this pane is open, click on one of the devices shown above, and its folders will be 
displayed. Now you can select folders and click “Stop scanning selected folders”. 

Clicking Reveal folder will open a Windows Explorer window showing the selected folder and 
its contents. 

Double-clicking a folder in the list of Scanned Folders will display its subfolders (if any) in the 
Subfolders window, and the projects (if any) contained inside it, in the Projects window. 

Select a project in the right hand list, then click List Media in Project to display a new 
window containing all media in the Media folder of the project. Click Delete Project to 
remove the project from the hard disk. You will be prompted to remove all the media in the 
Media folder. 

Creating New Projects 

Once Media Devices have been set up on your Dream II system for Audio and Video, you are 
ready to create a New Project. To do this, Press the Project key on your Dream II controller 
followed by the New softkey – or, select File/New from the Dream II pulldown menu. You will 
see the following dialog: 
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Choose a Project Type (MT or DR2).  

By default, your project is created in its own subfolder named with the Project Name. This is 
the recommended practice, as it helps keep your Dream II system organized. If you prefer, 
you can place your projects elsewhere – as long as you select a designated Media Device. 

Give your project a name and select the appropriate options. You are ready to begin! 

Backup Project to Folder 

Both MT files and DR2 files can be backed up using ‘File’ menu - ‘Backup Project to Folder’ 
option. This feature copies the project file and all the associated media files (audio and video) 
to the designated folders. 

Backup Project to Folder places all files associated with a project in a single place, making it 
easy to restore them later. Many facilities use inexpensive USB drives for backup. Restoring 
files is simply a matter of dragging and dropping files from the backup folder to the 
appropriate Audio and Video Media Devices. 
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Chapter 21 - Timecode Setup 

Introduction 

The Sync Setup Menu is used to configure the Project’s synchronisation setup. 
  

Step 1 Click the Sync Setup button in the Setup megamode. 

Step 2 The following dialog is displayed 

 

Sample Rate 

This is set when a project is created, and cannot be changed thereafter. 

Frame Rate 

Can be changed at any time. Normally it is best to choose the frame rate of the Master video 
device in your system, or of the timecode being chased, if any. 

Bit Depth 

Can be changed at any time. All subsequent recordings will have this depth. 

Extn Video Rate 

This is the rate of the external video reference applied to the SX-20. This must be set 
properly for correct operation! 

Pull Up/Down 

Allows setting of Pull Up and Pull Down, often used in NTSC video setups. Detailed 
explanation below. 

Sync Source 

The system sample rate is synchronised to its clock source. There are many choices, but 
normally you will use the SX20 as a sync source, and lock it to whichever sync signal your 
studio is running. 

Synchronization Indicators 

Det’ Sample Rate 

Detected Sample Rate indicates the speed at which Pyxis G2 is running. This value is 
determined by the relationship between the External Video Rate, the project Frame Rate, the 
Pull Up/Down setting and the project Sample Rate. 
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Video Detect 

The Video Clock Detected indicator is green when a valid Video Clock reference is detected 
and red when Video Clock is missing or invalid. 

Seeking Lock 

The Seeking Lock indicator is green when seeking lock, and red when not in use or locked. 

Sync 

The Sync indicator is green when a valid Clock Sync Source reference is detected, and red 
when the Clock Sync Source is missing or invalid. 

Progressive Detect 

SX-20 supports both Progressive and Interlaced clocks. If the Progressive Clock Detect 
indicator is green, a Progressive Clock reference has been detected and is being used as the 
primary sync reference. 

Clock In Range 

The Clock In Range indicator is green when the Clock reference is in range and red when the 
clock reference is out of range. 

Position Sync 

When synchronising with an external machine such as a video machine, audio recorder or 
digital audio workstation, a positional source allows the machines to “tell” each other where 
they are. The Position Sync Source indicator is green when a valid Position Sync Source 
reference is detected, and red when the Position Sync Source is missing or invalid. 

Synchronization Details 

Pyxis G2 can track the position and motion of external transports such as a video tape 
recorder, timecode-striped audio tape or a timecode generator. The disk recorder will play in 
time with the Master Timecode source so that sound and picture coincide. 

Position 

This is an absolute location reference to a sequence of pictures or audio. It is used to 
determine whether the disk recorder is playing the right part of its Project. For video, position 
reference is usually provided by 9 pin (Sony protocol from an RS-422 port). For audio tapes 
LTC is normally used (though 9 pin is also a possibility). 

Motion 

The motion of an external machine is a measure of its speed, and the disk recorder must 
move at the same speed to remain in sync. This translates into producing the correct number 
of samples every second, which is called the Master Clock rate. This can be locked to a Digital 
Word Clock, a video signal, an AES/EBU signal, by the internal crystal, a timecode source, or 
a digital audio source which is being recorded. 

If the Position Reference and Motion References are not the same, it is possible that they will 
drift apart over time. This will be shown by a warning at the top of Pyxis G2 ’s video screen 
which indicates when an inconsistent timecode frame was encountered. 
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How Pyxis G2  Synchronises 

Pyxis G2 goes through a number of steps in achieving synchronization in play mode: 

1. Read the position reference and start loading up the corresponding audio on all 
active tracks. 

2. When ready, start playing, but with the outputs muted. Use variable speed to reduce 
the error between the Pyxis G2 position and the Position Reference until it is very 
small. 

3. Switch to the Motion Reference for continued playback. The system is said to be 
locked once this switch is made, and the audio is unmuted. 

4. Warn of error status if the sync error increases, if a reference signal is lost etc. 

Synchronization Conflicts 

When you are recording a digital source, it must be synchronised to the same Master Clock 
Reference as Pyxis G2, or an overflow (too many samples) or underflow (too few samples) 
may occur at the input. This causes a characteristic, periodic form of digital distortion called a 
whisper. A whisper sounds like a brief, glassy or metallic buzz, and occurs about once every 
few seconds, depending how fast the samples are overflowing or underflowing. 

The best solution to digital sync conflicts is to drive all digital devices from a single, studio-
wide word clock signal. Then all devices will have identical word rates, so whispers never 
occur and digital interconnections may made with ease. In this instance, the sync HOUSE 
option is always used. 

Pull-Up and Pull-Down 

The normal sample rates used by the digital audio industry are 32,000, 44,056. 44,100, 
48,000 and 96,000 samples per second. The normal frame rates are 24, 25, 29.97 and 30. 
These last two may cause confusion when used together. 

Pyxis G2 can alter its sample rates far enough to accommodate the small speed change 
caused by going from 30 to 29.97 frames per second and back again.  

In other words, if you slow down the frame rate from 30 to 29.97, Pyxis G2 can slow its 
internal sample rate to match. This is called Pull-up or Pull-down, depending in which 
direction you are taking the speed. 

When you choose a frame rate you are telling Pyxis G2 what frame rate to expect. To put it 
more accurately, you are telling it the frame rate at which the chosen sample rate will be 
accurately reproduced. For example, if you tell Pyxis G2 that the NTSC frame rate is 30 (in 
the Setup Menu) and the sample rate is 44,100, it will pull down the sample rate to 44,056 if 
you feed in timecode at 29.97.  

If, however, you change the NTSC field to 29.97, Pyxis G2 will play at 44,100 at 29.97 frames 
per second, and will pull up to a sample rate of 44,144 when timecode runs at 30 frames per 
second. 

It is advisable to choose a sample rate at which you want to make the final transfer of the 
Project. Then record your material at whichever frame rate is going to be used during that 
final transfer. The importance of this choice is that you do not want to compromise the 
quality of your final product by using sample rate conversion at the moment it leaves Pyxis 
G2 for the last time.  

You should make these choices at the very beginning of the Project, and then you may use 
any other combination that suits your purposes temporarily during the recording and editing 
process.
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Chapter 22 - Machine Control 

Introduction  

Pyxis G2 can communicate with industry standard Sony 9 pin serial controlled machines (with 
a timecode reader installed) providing control over external video (or audio) machines, 
directly from the Constellation. 

Constellation-XT can control up to three machines: M1, M2 and M3. Of these, two can be 
physical VTRs, and the third can be Linear Timecode or MIDI Timecode. 

Setting up Machines 

To choose a machine type to be M1, M2 or M3. 

Step 1 Click the 9 pin Setup button in the Setup megamode. 

Step 2 The following Smart Pane is displayed 

 

 

 

For each machine that you want to use, select one of the following machine types: 

 TC Master – the selected machine is the 9 Pin timecode master. 

 Chase (slave) - the selected machine is in 9 Pin chase mode. 

 Remote (slave) – Dream II will respond to 9 Pin remote commands like a “virtual 
VTR”. 

 LTC Master – the selected machine is set to chase external Longitudinal Time Code. 

 MTC Master – the selected machine is set to chase external MIDI Time Code. 

 Pyxis – selecting Pyxis Track as one of your machines allows you to take the Video 
Track “offline” the same way as physical machines. See Editing with Machine Control 
on page 148 to see how this works. 

 No Port – No port selected 
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Note: You can have only one Master machine at a time, but you can have as many slave 
machines as you like (limited only by available ports). Master and Slave machines can be 
used concurrently. 

To place a machine online, select the Enable checkbox in the Sync Setup Smart Pane, or click 
the M1, M2, or M3 button in the Status bar. 

Enter an Offset if desired. 

Use the red Video, Analog and Digital LEDs to arm tracks on your remote devide as required.  

Note:  The master ‘Video Arm Enabled’ box must be checked and each video ‘Arm En’ box 
must also be checked on the desired device before the Video arm LED can be used to arm 
the video track. 

Click the ‘Eject’ button to eject tape from the desired device. 

Note that controls will only appear if they are relevant to the selected device type. 

Config 

Click the Config button to set transport ballistics for the different machine types. 

When a machine (M1 or M2) with this setting is placed on-line, it means that DREAM II will 
control the transport of a 9-pin machine, but will chase the position of that machine in all 
transport modes. In this case the Config Window looks like this: 
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Locate Method 

Select between Cue Only (operates only in Cue mode) or Unlace (unlaces a tape machine and 
puts it in Fast Forward or Rewind when the locate distance more than the number in the Lace 
Window. This allows for faster locates for video tape recorders. 

Lace Window 

Causes the machine to unlace if it is given a locate command outside the range of this 
window. Unlacing allows the machine to travel faster, and reduces head wear. 

Tracking Algorithm 

Determines how the machine performs when searching for timecode. Each machine may 
perform better with either choice of algorithm. 

Bi-Directional Control 

When switched on, allows either the Master or the Slave to instigate transport commands 
(e.g. Play, Stop etc). 
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Edit Delay (frames) 

Each VTR has a built-in delay between receiving the Edit command (equivalent to a pre-
programmed Record command) and actually entering the Edit mode. If you the Edit Delay to 
match the machine’s behaviour, Dream II will issue the Edit command early so that the VTR 
enters Edit at the right time. 

Confidence Head 

Switches the video machine’s Confidence Head on or off. 

Stop Command 

Allows the option of keeping the VTR tape on the heads when the machine stops. This will 
allow it to start playing much quicker, but it does increase head wear. 

Head Protect 

Specifies a time after which the tape is removed from the heads automatically, to prevent 
wear. 

Play Tracking 

Determines how many incorrect frames the system must see before it jumps to be in sync 
with the incoming timecode, or stops if no timecode is coming in. This allows the system to 
keep playing over timecode that has gaps. 

Record Tracking 

As with Play Tracking, but recording uses a different number. This is because recording 
sometimes needs to be more tolerant. Note that, if timecode sync is lost during recording, 
then re-established, the transport will go back into Play, but not into Record. 

Run Lock 

If the Play Run Lock checkbox is ticked, the system will continue to play after first achieving 
lock to timecode, no matter what the timecode does. 

The lower Run Lock checkbox provides the same option when recording. 

 

As for TC Master, but there is an individual choice of tracking algorithm for Play and Jog. 



Operator Reference Manual  CHAPTER 22 - MACHINE CONTROL September 15, 2011 
 

Pyxis G2 Page 146 

Remote (Slave) Mode 

When a machine (M1 or M2) with this setting is placed on-line, it means that DREAM II 
emulates a 9-pin machine, and will obey commands sent to it. It is the master for timecode. 
At the same time, its transport controls are active. 

 

Select 9-pin ID 

Allows you to choose the type of machine being emulated by Pyxis. This allows for slight 
variations in the 9-pin protocol. 

Status Sense Play Tally 

Controls an aspect of 9-pin performance. 

This parameter controls the value of  bit0 #0 Byte#1 in the Sony Protocol command: “0x7X 
0x20” Status Data (sent from DreamII system to the Sony master device, in response to the 
“0x61 0x20” Status sense command.). If “Play Only” is set, the value of this bit is 1 only when 
Dream is in Play or Record modes. If “Play and varispeed” is set, the value of this bit is 1 
when Dream is in Play, Record or varispeed modes. 

Some equipment (e.g. DspMedia postation) requires this parameter to be set to Play only, to 
work correctly. Some equipment, (e.g. SoundMaster), requires this parameter to be set to 
Play and Varispeed to work correctly. 

 

LTC Chase 

When a machine (M1 or M2) with this setting is placed on-line, it means that Pyxis G2 will 
chase Longitudinal Time Code entering the SMPTE In port on the SX-20. 

 

Play Tracking 

Determines how many incorrect frames the system must see before it jumps to be in sync 
with the incoming timecode, or stops if no timecode is coming in. This allows the system to 
keep playing over timecode that has gaps. 
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Record Tracking 

As with Play Tracking, but recording uses a different number. This is because recording 
sometimes needs to be more tolerant. Note that, if timecode sync is lost during recording, 
then re-established, the transport will go back into Play, but not into Record. 

Run Lock 

If the Play Run Lock checkbox is ticked, the system will continue to play after first achieving 
lock to timecode, no matter what the timecode does. 

The lower Run Lock checkbox provides the same option when recording. 

MTC Chase 

When a machine (M1 or M2) with this setting is placed on-line, it means that DREAM II will 
chase MIDI Time Code entering the MIDI In port on the SX-20. The settings are identical to 
those for LTC Chase. 

Machine Control Indicators 

Name 

Name of the 9 Pin Device. 

Servo LEDs 

The left Servo LED is green when the 9 Pin device has servo lock. The right Servo LED is 
green when the 9 Pin device has sync lock. For correct operation with 9 Pin devices, both 
LEDs should be green. 

Timecode 

Displays the current timecode position of the external device. 

Status 

Displays the device status. 

Offset 

Displays the device offset. 

Asm 

Indicates the 9 Pin device is in Assembly Edit Mode. 

Inh 

Indicates the 9 Pin device is in Record Inhibit mode. 

Ref 

Indicates the 9 Pin device is receiving a valid external sync reference. 

LTC Generator 

The LTC generator is an independent “machine” which can be controlled from the Smart 
Panel or from the work surface. 
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The Gen key on the work surface toggles the generator on and off. The checkbox on the left 
also does this. 

 

It has its own offset field, shown to the right of its name. 

When the In Stop checkbox is ticked, a repeated timecode frame is generated when the 
transport is stationary. Otherwise, timecode is generated only in Play. 

Putting Machines Online 

Machines stay in stop and are ignored by the DREAM system while offline. To put a machine 
online, do one of the following: 

 Select the Enable checkbox in the Sync Setup Smart Pane 

 

 Click the M1, M2, or M3 button in the Status bar. 

Editing with Machine Control 

All the transport controls and locating methods operate with a 9 pin remote machine online. 
The following procedure is used to place new recordings or previously used clips to picture. 

Press the M1 key to toggle the 9 pin machine on or off. Constellation s transport will locate to 
the timecode from the 9 pin machine. The system defaults to M1 controlling 9 pin Port A. 

Placing Sound to Picture 

Step 1 With M1 online, locate the video at the desired frame. 

Step 2 Take M1 offline. 

Step 3 Locate the transport so the cursor lies on the sync point of the clip. 

Step 4 CUT or COPY the clip to the clipboard. 

Step 5 Place M1 online – the transport will relocate to the video at the desired frame. 

Step 6 Press <Enter> to paste the clip.  

It is also possible to CUT or COPY the clip before locating to the desired frame.
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Chapter 23 - HUI Slave Mode 

Introduction 

HUI is a protocol invented by Mackie Corporation, which allows different audio systems to control each 
other.  

Many consoles and other devices now incorporate aspects of the HUI protocol, and Constellation-XY has 
implemented the full specification as a slave, including the Universal Pro Extensions. This allows the 
following functions to be controlled remotely: 

 Transport states including Jog and Shuttle 

 Jog Frames (i.e. the system can be jogged remotely) 

 Fader levels (bidirectional for motor control) 

 Mutes, Solos, Track Arms, Channel Selects (note: Channel Select will arm a track if the Arm or 
ADR menu is current) 

 Channel names (the first 4 characters, to be displayed on the controller) 

 Buttons on the controller can be mapped to Dream II functions. 

Setup 

Install HUI device 

Your HUI device will come with its own installer, cables and instructions. Follow these and make sure 
the HUI device is working correctly. 

INI File 

The file C:\Program Files\Fairlight\FMC\FMC.ini must contain the line 

HUI,n 

Where n is the number of faders on the HUI device (default 8). 

Just doing this will result in faders, mutes, pans, solos and selects from your HUI device working 
correctly on the Xynergi system. That is to say, they will act and will also tally the changes. 

MIDI Devices 

For HUI to work, the Xynergi system must know which MIDI devices to expect. These are written into 
the file HUISetup.txt, which is normally found here: C:\Program Files\Fairlight\FMC\Data. 

Open the HUISetup.txt file. It already contains the necessary setup for three HUI devices: a Roland 
Edirol interface, a MOTU Microlite 4-port MIDI interface, and a Tranzport controller (this is for wireless 
control of basic functions only). If you want to make life easy for yourself, buy an Edirol or a MOTU 
Microlite, and just enable it by removing the hashes (#) in front of the lines in HUISetup. 

The following procedure assumes you have some other kind of HUI controller. Your task now is to find 
out the names of its MIDI ports and write them into the HUISetup file, in the same way as the existing 
entries. (If this sounds too complicated, get your Fairlight service provider to help – it’s a one-time setup 
in most cases.) 

First you’ll need to identify the MIDI devices attached to your system. Connect your HUI controller via 
MIDI or USB. To see a list of the MIDI devices seen by Dream II, we’ll use our debugging program, 
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MSAT. Start MSAT before starting FMC (the Mixer program). If Dream II is already running, stop FMC as 
follows: 

Step 1 Click on the Mixer screen to give it focus 

Step 2 Type ctrl+Shift+Q 

Step 3 Type y to confirm closure of FMC 

Start MSAT using: 

Start  All Programs  Fairlight  FMC  FMC Utils  MSAT 

Shortly after starting it, if FMC is running, you’ll see an error message about incompatible file versions, 
which can be ignored. 

 

Now start FMC using: 

Start  All Programs  Fairlight  FMC  FMC 

Early in the boot process, FMC will report on the MIDI devices. When you see it, click the red Stop 
button in the upper left of the MSAT screen to freeze the display. It will look something like this: 
Comms is ONLINE 
GDB - 09:42:59 > Physical Memory Available: 705492K 
GDB - 09:42:59 > Mix Memory allocated: 39062K 
GDB - 09:42:59 > FMC is ONLINE 
GDB - 09:42:59 > FMC re-sync 
GDB - 09:43:00 > Disabling UI Completed 
GDB - 09:43:00 > FaderCount: 8 
GDB - 09:43:00 > Midi IN 0 of 4 name: USB Audio Device 
GDB - 09:43:00 > MIDI-in device:0 
GDB - 09:43:00 >    manufacturer:65535 
GDB - 09:43:00 >         product:65535 
GDB - 09:43:00 >         version:1.1 
GDB - 09:43:00 >            name:USB Audio Device 
GDB - 09:43:00 > Midi IN 1 of 4 name: USB Audio Device [2] 
GDB - 09:43:00 > MIDI-in device:1 
GDB - 09:43:00 >    manufacturer:65535 
GDB - 09:43:00 >         product:65535 
GDB - 09:43:00 >         version:1.1 
GDB - 09:43:00 >            name:USB Audio Device [2] 
GDB - 09:43:00 > Midi IN 2 of 4 name: USB Audio Device [3] 
GDB - 09:43:00 > MIDI-in device:2 
GDB - 09:43:00 >    manufacturer:65535 
GDB - 09:43:00 >         product:65535 
GDB - 09:43:00 >         version:1.1 
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GDB - 09:43:00 >            name:USB Audio Device [3] 
GDB - 09:43:00 > Midi IN 3 of 4 name: USB Audio Device [4] 
GDB - 09:43:00 > MIDI-in device:3 
GDB - 09:43:00 >    manufacturer:65535 
GDB - 09:43:00 >         product:65535 
GDB - 09:43:00 >         version:1.1 
GDB - 09:43:00 >            name:USB Audio Device [4] 
GDB - 09:43:00 > Midi Out 0 of 5 name: USB Audio Device 
GDB - 09:43:00 > MIDI-Out device:0 
GDB - 09:43:00 >    manufacturer:65535 
GDB - 09:43:00 >         product:65535 
GDB - 09:43:00 >         version:1.1 
GDB - 09:43:00 >            name:USB Audio Device 
GDB - 09:43:00 > Midi Out 1 of 5 name: USB Audio Device [2] 
GDB - 09:43:00 > MIDI-Out device:1 
GDB - 09:43:00 >    manufacturer:65535 
GDB - 09:43:00 >         product:65535 
GDB - 09:43:00 >         version:1.1 
GDB - 09:43:00 >            name:USB Audio Device [2] 
GDB - 09:43:00 > Midi Out 2 of 5 name: USB Audio Device [3] 
GDB - 09:43:00 > MIDI-Out device:2 
GDB - 09:43:00 >    manufacturer:65535 
GDB - 09:43:00 >         product:65535 
GDB - 09:43:00 >         version:1.1 
GDB - 09:43:00 >            name:USB Audio Device [3] 
GDB - 09:43:00 > Midi Out 3 of 5 name: USB Audio Device [4] 
GDB - 09:43:00 > MIDI-Out device:3 
GDB - 09:43:00 >    manufacturer:65535 
GDB - 09:43:00 >         product:65535 
GDB - 09:43:00 >         version:1.1 
GDB - 09:43:00 >            name:USB Audio Device [4] 
GDB - 09:43:00 > Midi Out 4 of 5 name: Microsoft GS Wavetable SW Synth 
GDB - 09:43:00 > MIDI-Out device:4 
GDB - 09:43:00 >    manufacturer:1 
GDB - 09:43:00 >         product:102 
GDB - 09:43:00 >         version:5.10 
GDB - 09:43:00 >            name:Microsoft GS Wavetable SW Synth 
GDB - 09:43:00 > Using MIMidi Out 0 

A number of MIDI devices may be presented, not necessarily with useful names (this depends on the 
driver for the device). At the end, the line … 

GDB - 09:43:00 > Using MIMidi Out 0 

… tells you which MIDI device the system is using. If this is clearly not your HUI device, nothing is going 
to work. In the example given, it is possible to see that Microsoft GS Wavetable SW Synth has not been 
selected. 
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Remap File 

If you want transport control, or any other key events to work, you must place a file called remap.txt in 
the following folder: 

 C:\Program Files\Fairlight\FMC\Data\User\username 

Where username is the log-on name used on your computer. 

The remap file takes keys coming in from the HUI device, and routes them to keys on your Dream II 
system. Here is the text in one remap file: 

CID_SW_MACKIE_STOP,CID_SW_STOP 
CID_SW_MACKIE_REWIND,CID_SW_REW 
CID_SW_MACKIE_FAST_FWD,CID_SW_FF 
CID_SW_MACKIE_PLAY,CID_SW_PLAY 
CID_SW_MACKIE_RECORD,CID_SW_REC 
CID_SW_MACKIE_ALT,CID_SW_BLUE_1 (Blue key) 
CID_SW_MACKIE_ENTER,CID_SW_ENTER 
CID_SW_MACKIE_ZOOM,CID_SW_ZOOM 
CID_SW_MACKIE_LEFT,CID_SW_RNGE_JUMP_LEFT 
CID_SW_MACKIE_RIGHT,CID_SW_RNGE_JUMP_RIGHT 
CID_SW_MACKIE_MARKER,CID_SW_GAP_FROM 
CID_SW_MACKIE_NUDGE,CID_SW_GAP_TO 
CID_SW_MACKIE_SCRUB,CID_SW_SHUT_JOG (turns Jog on) 
CID_JOG_MACKIE_WHEEL,CID_JO_JOGGER (this assigns the HUI jogger to the Dream II jogger) 
CID_SW_MACKIE_READ,CID_SW_EN_FADER_2 (enables faders for automation) 
CID_SW_MACKIE_WRITE,CID_SW_EN_MUTE_2 (enables mutess for automation) 
CID_SW_MACKIE_TOUCH,CID_SW_EN_PAN_1 (enables pan parameters for automation) 
CID_SW_MACKIE_TRIM,CID_SW_EN_EQ_GROUP (enables EQ parameters for automation) 
CID_SW_MACKIE_LATCH,CID_SW_EN_DYN_GROUP (enables dynamics parameters for automation) 
CID_SW_MACKIE_GROUP,CID_SW_EN_AUX_GROUP (enables aux send parameters for automation) 

Examining this line: CID_SW_MACKIE_STOP,CID_SW_STOP, we see that the first part is the HUI stop 
key, and the second part is the Dream II soft key. This will cause the HUI stop key to work on Dream II. 

There are some HUI keys not mentioned in this remap file. They are listed below.  
CID_SW_MACKIE_BANK_DOWN 
CID_SW_MACKIE_BANK_UP 
CID_SW_MACKIE_CHANNEL_DOWN 
CID_SW_MACKIE_CHANNEL_UP 
CID_SW_MACKIE_UP 
CID_SW_MACKIE_DOWN 
CID_SW_MACKIE_SHIFT 
CID_SW_MACKIE_CONTROL 
CID_SW_MACKIE_F1 
CID_SW_MACKIE_F2 
CID_SW_MACKIE_F3 
CID_SW_MACKIE_F4 
CID_SW_MACKIE_F5 
CID_SW_MACKIE_F6 
CID_SW_MACKIE_F7 
CID_SW_MACKIE_F8 
CID_SW_MACKIE_MIDI_TRACKS 
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CID_SW_MACKIE_INPUTS 
CID_SW_MACKIE_AUDIO_TRACKS 
CID_SW_MACKIE_AUDIO_INSTRUMENT 
CID_SW_MACKIE_AUX 
CID_SW_MACKIE_BUSSES 
CID_SW_MACKIE_OUTPUTS 
CID_SW_MACKIE_USER 
CID_SW_MACKIE_OPTION 
CID_SW_MACKIE_SAVE 
CID_SW_MACKIE_UNDO 
CID_SW_MACKIE_CANCEL 
CID_SW_MACKIE_SOLO 
CID_SW_MACKIE_DROP 
CID_SW_MACKIE_CYCLE 
CID_SW_MACKIE_DISPLAY_SMPTE 

You may add any of these to your remap file, and assign them to any Dream II key. For help with 
Dream II key assignment, please consult your Fairlight customer support organization. 

Remap to Macros 

One easy way to get more power from HUI keys is to map them to your macros. An example of a 
mapping line that does this: 

CID_SW_MACKIE_F1,CID_SW_M_1  
CID_SW_MACKIE_INPUTS,CID_SW_BANK_1  

Using macro and bank assignments you can get access to 27 macro keys. 

Identifying Keys 

On some HUI controllers, the key labelling may not match the list above. You can find out the name of 
any HUI key using the following method: 

 Step 1 Start the system and load a project (can be empty) 

Step 2 Start the MSAT application 

StartAll ProgramsFairlightFMCFMC UtilsFMC 

Step 3 If you see this error message at any time, click OK (it doesn’t mean anything is wrong) 

 

Step 4 Click buttons at the top of the MSAT screen so that Msg Gen is on, Msg Sys is off, and All Para is 
off, as shown below. 
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Step 5 Type ctrl+SHIFT+0 then turn on Control message display using the Debug Switch Control 
dialog as shown below (set the switch value to 1). Then close the dialog. 

 

Step 6 Press a HUI key and observe the MSAT display. It will show you the name of the key. 

 

In the example shown, the keys CID_SW_MACKIE_F1 and CID_SW_MACKIE_F2 have been 
pressed (and released, hence two events per key). 



Operator Reference Manual  CHAPTER 23 - HUI SLAVE MODE September 15, 2011 
 

Pyxis G2 Page 155 

 Advanced – using Scripted Macros 

In Xynergi a number of the HUI keys have been used to trigger scripted macros, as follows. 
CID_SW_MACKIE_BANK_DOWN decrement_fader_set 
CID_SW_MACKIE_BANK_UP increment_fader_set 
CID_SW_MACKIE_CHANNEL_DOWN decrement4_fader_set (jump by four fader sets) 
CID_SW_MACKIE_CHANNEL_UP increment4_fader_set (jump by four fader sets) 
CID_SW_MACKIE_UP,EQUAL less_tracks (show fewer tracks on the edit screen) 
CID_SW_MACKIE_DOWN,EQUAL more_tracks (show more tracks on the edit screen) 

If you wish to release one of the HUI keys for other functions, you must edit the Events.txt file in  
C:\Program Files\Fairlight\FMC\Data\User\Xynergi_ 

For example, to liberate CID_SW_MACKIE_BANK_DOWN, add a hash (#) in front of the line: 

CONTROL,CID_SW_MACKIE_BANK_DOWN,EQUAL,1,decrement_fader_set like this: 

#CONTROL,CID_SW_MACKIE_BANK_DOWN,EQUAL,1,decrement_fader_set 

Then you can use CID_SW_MACKIE_BANK_DOWN in your remap file, or trigger a different scripted 
macro. 
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Chapter 24 - System Files 

Introduction 

Pyxis G2 uses a number of files to store setup information. These are normally set to sensible 
values at the factory, but in some cases you may need to change them.  

Working with Pyxis G2 System Files 

System files are stored in the C:\Program Files\Fairlight\FMC\Data directory. Use Windows 
explorer or use the trackball to click on My Computer, on the desktop, to navigate through 
the file system. Use the Notepad text editor to edit files by double clicking on the file name. 

The I-O Config.TXT File 

The I-O Config.txt file specifies what I/O hardware is fitted with your CC-1 engine. This file 
must be edited to allow the Pyxis G2 to properly address the physical I/O hardware. The I-O 
Config.txt file is stored in C:\Program Files\Fairlight\FMC\Data directory. Open the file with the 
Notepad text editor, define the physical I/O as described in the file. You can also name indi-
vidual I/Os which will then bring their names up on the FAT channel when you patch them. 

System Ports 

System output ports can only be accessed from the Monitor Setup Patch Outputs menu. 
Using system ports for control room monitors prevents the operator from inadvertently 
patching signals direct to the power amplifier inputs. To define a system port enter an 
attribute value of 1 as described in the I-O Config file. 

The file contents are similar to the following: 
# -------------------------------------------------------- 

# I/O configuration 

# There are three types of I/O: 

# 1 is Analog 

# 2 is AES 

# 3 is MADI 

# -------------------------------------------------------- 

# First define the number of different types of I/O: 

# IO_CONFIG,type,inputs,outputs 

# where 

# IO_CONFIG,1,16,8 

# IO_CONFIG,2,32,16 

# IO_CONFIG,3,0,0 

# would configure the system with 16 analog IPs, 8 analog 

# outputs, 32 digital IPs, 16 digital OPs and no MADI 

# -------------------------------------------------------- 

# These ports are then define one by one using a number 
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# of statements like these: 

# INPUT,type,index,name,attibutes 

# OUTPUT,type,index,name,attibutes 

# Note, that the index counts from 1, and that the name 

# must be less than 12 characters long. 

# The attribute can be omitted; a value of 1 specifies the 

# port to be a system port. 

# --------------------------------------------------------- 

# This system has 32 analog IPs, 32 analog 

# outputs, 32 digital IPs, 32 digital OPs and no MADI. 

# Digital Inputs 1&2 are named DAT L&R respectively 

# Analog Outputs 25&26 are named Main Mon L&R respectively 

IO_CONFIG,1,32,32 

IO_CONFIG,2,32,32 

IO_CONFIG,3,0,0 

INPUT,2,1,DAT L 

INPUT,2,2,DAT R 

OUTPUT,1,25,Main Mon L,1 

OUTPUT,1,26,Main Mon R,1 

The Monitor_Matrix.TXT File 

The monitor matrix file is a text file which contains a complete set of upmix and downmix 
matrix coefficients. These are used when monitoring a larger format bus on a smaller format 
speaker set, or when selecting a larger or smaller monitoring format than the current monitor 
source bus. 

Monitor Downmix Matrix Defaults 

The monitoring downmix matrix allows any source format to be monitored on any format 
speaker system. The elements of the source signal path are distributed or summed and 
attenuated as necessary to maintain the soundfield image in the target format. 

When monitoring a source format with less elements than the current monitor format, the 
elements in the source format that also appear in the monitoring format are passed through 
to their respective loudspeakers unmodified. For example, when monitoring a stereo bus 
through a 5.1 speaker system, the left and right bus elements appear in the left and right 
speakers and the centre and surround speakers are ignored. The exception to this where the 
source format contains a centre or centre surround element and the target format does not. 
In these cases the centre channel is distributed between left and right elements 

Bass Management 

The default monitor matrix eliminates the boom or LFE channel when downmixing to a format 
that does not include a boom channel. If it is desired to add the boom signal into the front 
monitors this may be done by adding the appropriate entries to the monitor matrix file as 
described below. 
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Editing the Monitor_Matrix File 

The monitor matrix data is contained in a readable text file on the Pyxis G2 computer. The 
file specifies both downmix and upmix combinations. This file can be opened and edited to 
conform to your specific monitoring requirements.  

The file is laid out as a comma delimited table. Each downmix entry begins with a description 
prefixed with a # (e.g. #Stereo to Mono). Each subsequent row describes a node in the 
matrix and has the following elements: 

SET_NODE command, source format (e.g. Stereo), destination format (e.g. Mono), source 
element (e.g. Left), destination element (e.g. Centre), Gain in dB. 

For example, here is the entry for Stereo to Mono downmix: 

# Stereo to Mono 
SET_NODE,Stereo,Mono,Left,Centre,-3 
SET_NODE,Stereo,Mono,Right,Centre,-3 

Source elements that are not passed through to the destination do not appear in the 
downmix entry. 

Follow these steps to edit the monitor_matrix file: 

Step 1 Quit FMC by holding down the Shift key and pressing the Pause/Break key on the 
PC keyboard and typing Q then Y. 

Step 2 Use the trackball to double-click on the Start button on the task bar at the bottom 
left of the mixer screen. 

Step 3 Use the trackball to select Programs > Accessories > Notepad. Notepad is a basic 
text editor application. 

Step 4 In Notepad select Open from the File menu at the top of the screen. Navigate to the 
following file and click Open  
C:\Program Files\ Fairlight\FMC\Data\monitor_matrix.txt 

Step 5 Select File > Save As and type monitor_matrix.bak to save a back up copy, then 
File > Open C:\Program Files\ Fairlight\FMC\Data\monitor_matrix.txt to re-open the 
original file for editing. 

Step 6 Use the arrow keys to scroll down the file to the entry you wish to modify. Edit the 
gain value at the end of a line or type a new line to add an element (e.g. Boom). 

Step 7 When you have finished making changes click File > Save, then File > Exit to 
save the file and exit Notepad. 

Step 8 Click on the DREAM II Start Icon on the desktop to restart FMC and the disk 
recorder. 

Your modified monitor matrix settings are now active. 

Removing Boom from a Monitor Downmix 

The following setting sends the boom channel from a 5.1. bus to left and right speakers of a 
stereo monitor set: 

# 5.1 to Stereo 

SET_NODE,5.1,Stereo,Left,Left,0 
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SET_NODE,5.1,Stereo,Right,Right,0 

SET_NODE,5.1,Stereo,Centre,Left,-3 

SET_NODE,5.1,Stereo,Centre,Right,-3 

SET_NODE,5.1,Stereo,S-left,Left,0 

SET_NODE,5.1,Stereo,S-Right,Right,0 

SET_NODE,5.1,Stereo,Boom,Left,-3 

SET_NODE,5.1,Stereo,Boom,Right,-3 

Remove the last two lines to eliminate the boom element from the monitors as shown below: 

# 5.1 to Stereo 

#SET_NODE,5.1,Stereo,Left,Left,0 

#SET_NODE,5.1,Stereo,Right,Right,0 

#SET_NODE,5.1,Stereo,Centre,Left,-3 

#SET_NODE,5.1,Stereo,Centre,Right,-3 

#SET_NODE,5.1,Stereo,S-left,Left,0 

#SET_NODE,5.1,Stereo,S-Right,Right,0 

The System_Variables File 

The System_Variables file contains user configured setup parameters plus automatically 
generated system variables. Only modify the parameters described below. The file is located 
at C:\Program Files\Fairlight\FMC\Data\System_Variables.txt. To edit the file open it in Windows 
notepad as described above. 

Setting the Automation Lock Window 

The timecode lock window specifies the number of consecutive contiguous timecode frames 
that the automation system must read from the disk recorder before entering automation 
record. This prevents the system from dropping out of WRITE mode when locking to an 
external video transport. 

Edit the following line in System_Variables.txt: 

TC_LOCK_WINDOW,10 

Change the number at the end of the line to specify the number of frames. This number will 
also determine the amount of pre-roll required prior to performing an automation mix pass.  

Typical values are:  

TC_LOCK_WINDOW,1 for Vmotion. 

TC_LOCK_WINDOW,5 for Betacam. 

TC_LOCK_WINDOW,10 for U-matic. 

Setting the Automation Punch Preroll21 

The automation punch preroll sets the transport preroll time applied when using punch to 
enter automation record. Edit the following line to specify the preroll time in seconds. 
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TC_PUNCH_PREROLL,5 

Setting Momentary Talkback Time Threshold 

The Momentary Talkback Time Threshold defines the amount of time the talkback key must 
be held down to prevent the switch from latching. The default value is 500 milliseconds. 

Edit the following line in System_Variables.txt. Change the numerical value at the end of the 
line to specify the time threshold in milliseconds: 

MOMENTARY_TB_TIME_THRESHOLD,500 

Enabling AFL and PFL Modes 

AFL and PFL solo modes require two of the available buses. Disable AFL and PFL to free these 
buses.  

Edit the following line in System_Variables.txt. Change the numerical value at the end of the 
line to 1 for enabled or 0 to disable: 

AFL_PFL_ENABLED,1 

Joystick Snap 

The joystick snap setting defines the minimum distance in pixels, between the joystick 
bracket and the pan target in the channel display, required to capture the current pan 
position with the joystick. To alter the value edit the following line: 

JOYSTICK_SNAP,2 

Metering Numeric Peak Level 

The numeric peak levels displayed on the mixer display bus meters have a variable threshold. 
The level at which these values are displayed can be set in the System_Variables.txt file. Edit 
the following line in the file: 

PEAK_DISPLAY_LIMIT,950 

The value is from 0 to 1000 in 0.1dB steps where 1000 = full scale level. In the example 
above the value of 950 will cause the numeric display to first be shown when the signal level 
reaches -5dB below full scale. 970 will set the threshold to -3dB, 990 will set the threshold to 
-1dB, and so on. 

Overload Display Time 

Signal levels exceeding 0dBFS on the main meters are indicated by a overload hold display 
where all segments of the meter are illuminated orange. To clear this display press the Meter 
Sets key. The over hold time can be set by editing the following line in the file, enter the hold 
time in ten millisecond increments: 

Overload_display_time,1000 

Overload Peak Hold 

The main meters can display digital overloads by holding the entire bar. The amount of time 
this display remain after the overload has passed can be set. Edit the following line to enter 
the hold time in milliseconds. 

Overload_display_time,1000 
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GPIO Enable 

The GPIO port on the rear of the Pyxis G2 must be enabled for use by a GPIO macro. Replace 
the 0 with 1 in the following line to enable GPIOs. 

GPIO_ENABLED,0 

Plug-Ins I/O 

The physical digital I/O used by the optional plug-ins system must be specified. The I/O must 
be a block of 16 or 32 starting at 1, 17 or 33. Edit the following lines to specify the first 
channel and the range of the I/O block. 

PLUGINS_IO_START,17 

PLUGINS_IO_RANGE,16 

Plug-in Name Display 

The name of the plug-in may be displayed in the channel display. Edit the following line to 
turn this feature on or off. 

SHOW_PLUGIN_NAME,1 

Remote Mic amps 

To configure the Pyxis G2 to control a UP4 mic pre, add the following statement to the 
FMC.INI file: 

UP4,ip_address,x,y 

where: 

 ip_address is the address of the UP4 unit 

 x is the number of the first analogue input that it connects to (it MUST be connected 
to 4 consecutive inputs) 

 y is the number of UP4 units installed.  

Notes: 

 Multiple UP4s must use consecutive IP addresses in ascending order. 

 Inputs <X> must be counted starting from ZERO (0). 

FMC.ini and Command Line Options26 

FMC is launched automatically when you start DREAM II. 

FMC offers a number of additional command line options as listed below. These options may 
be used in a batch file for special applications. All start up options can also be set in the FMC 
initialisation file located at C:\Program Files\Fairlight\FMC\FMC.ini which overides the 
commandline options. If necessary, use the Notepad editor to edit the file. Click on the Start 
menu and select Programs>Accessories>Notepad and open the FMC.ini file. Note that the 
DREAM IIStart Setup page will overwrite the FMC.ini file. 
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FMC.ini 

FMC Commandline Options  
  

Option Description 

-c Run MSAT on the same machine as FMC ignoring the -p setting. 

-g Run without graphics. 

-h Hi-res mode (1600 x 1200) otherwise runs 1280 x 1024. 

-l Lo-res mode (1024 x 768). 

-m Enable mix automation. 

-p<###.###.###.###> Specify the IP address for a network connected machine running 
MSAT for testing. 

-s<#> Specify mixer type, where # = 0 for satellite, 1 for station48, 2 
for Pyxis G2 , 3 for station24. 

-u Disables “stop on wrong USB driver” message. FMC will still 
check the drivers, still report out of date drivers and will still say 
that it can't continue - but it will continue anyway. 

  

BLUE Utils Menu 

The BLUE Utils menu offers the Update Sys-File item for storage of system settings. 
System Files are stored in the C:\Program Files\Fairlight\FMC\Data\ directory. 

Step 1 Hold down the BLUE key and press the Utils key to enter the Utils menu.  

Step 2 Press the Update Sys-File soft key to store the system settings. This information is 
stored in the following files: 

Monitor_Sources.TXT - patching and formats of external monitor sources. 

Speaker_Sets.TXT - patching and formats of all speaker sets. 

Setup_Variables.TXT - Call Follow state and Pyxis G2 brightness. 
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Chapter 25 - Specifications 

Audio I/O Configuration 

See SX-20 and SX-48 installation guides for details. 

Pyxis G2 Wiring and Connection Details 

The following information contains all the wiring details necessary for specifying studio 
cabling installations. Connector sex described is the panel mount connector on the rear of the 
Pyxis G2. 

Meter USB  

Description: USB and DC Power connection for external meters. Note that Sidecars do not 
require DC power. Cable must be shielded and less than 3 meters in length. 

Connector: 5 Pin XLR Female   
  
XLR5 SIGNAL PAIR 

PIN 1 USB + 1 

PIN 2 0 VDC  

PIN 3 12 VDC  

PIN 4 0 VDC  

PIN 5 USB - 1 

SHELL SHIELD 1 

  

Talkback 

Description: Mic level input and line level output for studio talkback microphone. Mic input 
may be configured to carry +8VDC phantom power for electret and condenser microphones. 

Connector: D 9 Female 
  
9 Pin D Type 
Connector 

Signal Pair 

PIN 1 TB Out + 1 

PIN 2 TB Out GND/Shield 1 

PIN 3 TB In GND/Shield 2 

PIN 4 NC  

PIN 5 TB In + 2 

PIN 6 TB Out - 1 

PIN 7 NC  

PIN 8 NC  

PIN 9 TB In - 2 
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USB 

Description: Standard USB port. Cable must be shielded and less than 3 meters in length. 

Connector: USB Type A Female 
  

USB Type A 
Connector 

Signal 

PIN 1 +5VDC 

PIN 2 USBDO- 

PIN 3 USBDO+ 

PIN 4 GND 

  

GPIO 

Description: General Purpose I/O 

Connector: D 15 Female 

Input:low < 0.8 volts 
high > 3.5volts < 5 volts 
Input voltages higher than 5 volts may cause damage to internal circuitry. 

Output:low < 0.8 volts  
high >= 3.5 volts 
  
15 Pin D Type 

Connector 
Signal 15 Pin D Type 

Connector 
Signal 

PIN 1 GP In 1 PIN 9 GND 

PIN 2 GP In 2 PIN 10 GND 

PIN 3 GP In 3 PIN 11 GND 

PIN 4 GP In 4 PIN 12 GND 

PIN 5 GP Out 1 PIN 13 GND 

PIN 6 GP Out 2 PIN 14 GND 

PIN 7 GP Out 3 PIN 15 GND 

PIN 8 GP Out 4   

  
 

Ethernet 

Description: 100BaseT ethernet interface to Pyxis G2 or network. Use CAT5 shielded twisted 
pair cable and shielded RJ45 connectors. 

Connector: RJ45 
  
PIN 1 Rx 

+ 

PIN 2 Rx - 
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PIN 3 Tx 
+ 

PIN 6 Tx - 

  

Cross-over Cable 

Required for direct connection between Pyxis G2 and engine. Not required if hub is present. 
  
RJ45-1 Signal RJ45-2 

PIN 1 Rx + PIN 3 

PIN 2 Rx - PIN 6 

PIN 3 Tx + PIN 1 

PIN 6 Tx - PIN 2 
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